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Revision History

Revision Date Notes
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The operating system now runs on Ubuntu 20 Linux. 
Text, screenshots, and content structure were updated. 
This release also adds documentation for Research & 
Compliance mode, setup tools and communication, 
analog signal output, analog current signal output, Data 
File Viewer, contained exhaust flow, external valve 
sequencer, remote analyzer access, Linux keys and 
commands, and additional power requirements for 4–20 
mA operation.
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Picarro Notices
Thank you for purchasing a Picarro product. Your Picarro system is a quality product that was designed 
and manufactured to provide reliable performance.

This User Manual  is an important part of your purchase as it will help familiarize you with the system and 
explain the numerous features that have been designed into it. Please read this manual thoroughly 
before using your Picarro system.

Please contact Picarro or your authorized Picarro distributor should you have questions regarding 
specific applications or if you require additional information.

DISCLAIMER AND RESERVATION OF RIGHTS

Picarro has prepared this manual solely for the information and use by its customers as a guide for the 
selection, installation, operation, and maintenance of the products described.

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO PRODUCTS, 
PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO DISCLAIMS ANY EXPRESS OR 
IMPLIED WARRANTY, RELATING TO SALE OR USE OF PICARRO PRODUCTS, INCLUDING LIABILITY 
OR WARRANTIES RELATING TO MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Picarro reserves the right to change or update the contents of this manual and the specifications of its 
products at any time, without notice. Picarro has endeavored to include information that is current and 
accurate as of the date of the publication or revision of this document, but Picarro does not guarantee 
that this document is error free or that it is accurate regarding any particular specification.

Picarro expressly reserves all intellectual property rights, including all intellectual property rights relating 
to any product described in this manual. This document does not grant any license, express or implied, 
by estoppel or otherwise, to any intellectual property rights of Picarro or any third party.

PATENTS

The products described in this manual are subject to Picarro patents and patents pending. Information 
about Picarro patents applicable to these products is available at www.picarro.com/company/patents

TRADEMARKS

  Picarro and the Picarro logo are trademarks of Picarro, Inc.
  Linux® is a trademark of Linus Torvalds.

  RealVNC® is a registered trademark of RealVNC Limited

  Snoop® is a registered trademark of Swagelok Company.

  Swagelok® is a trademark of Swagelok Company.

  TeamViewer ® is a trademark of TeamViewer Germany GmbH.

Copyright © 2025 Picarro, Inc. All rights reserved.

https://www.picarro.com/company/patents
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1 Introduction
The Picarro PI2114 Hydrogen Peroxide Analyzer is designed for the accurate measurement 
of residual vaporized hydrogen peroxide, H2O2, in units of parts per billion (ppb). The unit 
uses Picarro’s patented Cavity Ring-Down Spectroscopy (CRDS) and wavelength 
monitoring to facilitate precise and continuous monitoring of vaporized hydrogen peroxide. 
The analyzer can detect levels of concentration as low as 3.3 ppb to ensure optimal 
manufacturing conditions.

In addition to this User Manual, the following documentation is required when installing 
the PI2114 analyzer:

Installation/Operational Qualification of the Picarro PI2114 Hydrogen Peroxide Analyzer, 
Document Number 50-0016.

This document (also referred to as “IQ/OQ”) provides instructions and the method of 
documentation to verify that the Picarro PI2114 has been installed and operates in 
accordance with the requirements of Picarro Instruments.

1.1   System Overview
This section provides an overview of the analyzer, related components, and specifications.

1.1.1 Analyzer
The following figure displays the analyzer front and back panels. More detailed information 
on panel features, functions, and connections are in Chapter 4, Hardware Setup.

LED Status Indicator USB Port

Figure 1 - PI2114 Front Panel

NOTE

1 2
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Sample Inlet

Vacuum Ports

4–20 mA Output

Analog Outputs

Power Connector and 
Switch

USB and Ethernet 
Ports

Display Ports

Serial Ports

Soft Power Button

Ground Connection

Figure 2 - PI2114 Back Panel

1.1.2 Front Panel Operating Status
The LED indicator on the front panel shows the current operating state of the analyzer. The 
following figure describes the status indicator states. The status states and colors are also 
linked to the System Alarm Panel on the CRDS Data Viewer Screen. See Section  .

Figure 3 - LED Status Indicator

1.1.3 A2000 Vacuum Pump
The A2000 vacuum pump is used to maintain cavity pressure inside the analyzer. The pump 
should be connected and running whenever the analyzer is in use.

1

2

3

4

5

6

7

8

9

10
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Figure 4 - A2000 Vacuum Pump - Side Views

1.2   Analyzer Specifications

Table 1 - PI2114 Specifications

Parameter Specification

Measurement Technique Cavity Ring-Down Spectroscopy (CRDS)

Weight: Total

Weight: Analyzer

Weight: Pump

61.9 lbs. (28.1 kg), including external  pump and vacuum 
tubing

21.3 kg (47 lbs.) – Should be lifted by  two people.

6.5 kg (14.4 lbs)  

Dimensions - Analyzer

Depth: 61.9 cm (24.38”)

Width: 44.5 cm (17.5”) (17.75” with  rails)

Height: 20.1 cm (7.88”)

Height with Feet: 21.3 cm (8.38”)

Dimensions – A2000 Pump

Length: 27.9 cm (11”)

Width: 10.2 cm (4”)

Height: 19.1 cm (7.5”)

Ambient Humidity Range < 85% RH non-condensing

Ambient Temperature 
Range

Operating: 10 °C to 35 °C (50 °F to 95  °F)    Storage:  -10 °C to 
50 °C (14 °F to  122 °F)

Maximum Altitude    (During 
operation)

3,048 m (10,000 ft. – Operation)
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Parameter Specification

Front/Rear Clearance Front: 15.3 cm (6”); Rear: 15.3 cm (6”)

Primary Gases Measured H2O2

Sample Flowrate   (at 760 
torr (101 kPa)

<1 slm

Required Accessories
Included: Pump (external), keyboard,  mouse

Supplied by Customer: LCD monitor

Operating System    Data 
Outputs

Windows 10    RS–232, Ethernet, USB, Analog (optional) 0-10 
V

Installation Benchtop or 48.3 cm (19”) rack mount

Power Requirements

Startup Power

Steady-state Power

100 – 240 VAC; 50/60Hz (auto-sensing)

<260 W at start-up, (Analyzer and  Pump)

110 W (Analyzer)

150 W (A2000 Pump)

Minimum Rated Circuit 
Amperage

10A @ 115 VAC

5A @ 230 VAC

Liquid Ingress Protection None

1.3   Acronyms
This manual includes various acronyms. For definitions, see below: 

Table 2 - Acronyms, Formulas, Units, and Symbols

Acronym Definition

“ (as in 
1/4”)

Inches

°C degrees Celsius

% Percentage

± Plus–minus sign
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Acronym Definition

< Less than

> Greater than

≤ Less than or equal to

≥ Greater than or equal to

A Ampere

AC Alternating Current

ASCII American Standard Code for Information Interchange

bar Metric unit of pressure. 1 bar = 100,000 pascals (Pa)

CH4 Methane

cm centimeters

CO2 Carbon Dioxide

COM Communication Port

CRDS Cavity Ring-Down Spectroscopy

CSV Comma Separated Values

CPU Central Processing Unit

DAS Data Acquisition System (the Analyzer)

DIO Digital Input/Output

DVI Digital Visual Interface

EMO Emergency Off

°F Degrees Fahrenheit

ft. Length in feet;1 ft. = 12” or 12 inches (30.48 cm)

GUI Graphical User Interface

H2O Water, Water Vapor

HB Hotbox
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Acronym Definition

HDF Hierarchical Data Format 

HDMI High-Definition Multimedia Interface

Hz Hertz

ID Inside Diameter (i.e., .5” ID) or Identification (i.e., Slave ID)

I/O Input/output

kg kilograms

kPa Kilopascal; unit of pressure; 1 kPa = 0.145 PSI

lbs pounds

m Meters or month

mA Milliampere

max Maximum

min Minimum

mK Millikelvin

mm millimeters / millimetre

N/C No Connection

NC Normally Closed

NH3 Ammonia

NO Normally Open

NTP Network Time Protocol

OD Outside Diameter

P Pressure

PC Personal Computer

PDF Portable Document Format

PFA
Perfluoroalkoxy – A chemically resistant polymer, suitable for use with sticky 
and aggressive gases
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Acronym Definition

PN Part Number

ppb parts per billion

ppm parts per million

PSI (psi) Pounds per Square Inch

PSIG Pounds per Square Gauge

PTFE Polytetrafluoroethylene

Pws Water vapor pressure

RH Relative Humidity

RJ-45 Registered Jack (physical network interface)

RS232 Recommended Standard 232 (serial communication protocol)

SNTP Simple Network Time Protocol

sec Seconds

SS/SST Stainless Steel

TCP/IP Transmission Control Protocol/Internet Protocol

Torr Torricelli (unit of pressure equal to 1/760 atmosphere)

UM User Manual

USB Universal Serial Bus

UPS Uninterruptible Power Supply

VA Volt-Ampere

VAC Volts Alternating Current

VDC Volts Direct Current

W Watts

WB Warmbox

WLM Wavelength Monitor
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1.4   Text Conventions
The following conventions are used in the manual.
 l Italic text identifies screen names and to emphasize important text or certain features.
 l Bold Italic text identifies section reference links.
 l Bold text is for actions to take (such as clicking on a UI button), caution and warning 

statements, and text you should type or select in screens.
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2 Safety
The following chapter provides an overview of warning symbols used in this document, 
general safety guidelines for using the analyzer, and acquired certifications.

2.1   Warning Symbols
The purpose of these icons is to provide a visual convention to alert you of important 
information. They indicate dangers to either the operator or to the product, and other 
important information. The following symbols are used in this manual.

DANGER indicates an imminently hazardous situation that, if not avoided, will result in 
death or severe injury.

WARNING indicates a potentially hazardous situation which, if not avoided, could result 
in death or severe injury.

HAZARDOUS VOLTAGE alerts user to areas that may expose a user to electrical energy 
that is high enough to cause injury or death.

LASER WARNING alerts user of a laser danger.

CAUTION alerts user of a potential danger to equipment or to the user.

HOT SURFACE alerts user to potential injury from hot surfaces.

DANGER

WARNING

WARNING

WARNING

CAUTION

HOT SURFACE
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The NOTE is important information to be aware of before proceeding.

REMINDER is a helpful hint for procedures listed in the text.

2.2   General Safety
This section describes the CDRH and CE certifications for class 1 lasers and regulatory 
conformity for the European Union.

2.2.1 CDRH Certification
This Picarro analyzer complies with 21 CFR Chapter 1, sub-chapter J, and is classified as a 
Class 1 laser system when all panels and covers are on.

2.2.2 CE Certification
This Picarro analyzer complies with the European standards and the instrument is affixed 
with a CE label. This CE label is located on the rear of the instrument.

Using this analyzer in a manner not specified by Picarro may result in damage to the 
analyzer and render it unsafe to operate

This analyzer is for indoor use only and has an ingress protection rating of IPx-0. 
Analyzer is not protected against exposure to water including dripping, spraying, 
splashing or immersion

Do not operate in an explosive atmosphere! Do not operate in the presence of flammable 
gases or fumes

NOTE

REMINDER

WARNING

WARNING

WARNING



2 Safety

PI2114 User Manual PN 40-0047, REV F 25

The analyzer contains no user serviceable components except the particulate filter, CPU 
fan, and A2000 vacuum pump diaphragms and valves. To order user-replaceable parts 
and access video replacement instructions, see section . 

Do not attempt repairs; instead, report all problems to Picarro Customer Support or your 
local distributor. Please contact Picarro if you have any questions regarding the safe 
operation of this equipment

Do not replace the mains supply power cord with an inadequately rated cord.

If mounting in a 19” rack, this analyzer cannot support itself using a front rack mount kit 
alone. It must be supported by a shelf, or by user-provided “L” type support brackets.

Equipment Damage: Exceeding gas inlet pressure or temperature specifications could 
result in damage to the instrument. In the case of higher input pressure or flow, 
configuring a sampling bypass manifold system is recommended.

Use a ‘tee’ at the gas inlet and exhaust the remainder of the gas stream appropriately.

The inlet gas connector on the back panel of the analyzer, and its immediate vicinity, 
runs hot during operation of the analyzer. Take care when connecting gas lines or 
working at the rear of the instrument to wear protective gloves or avoid contact with 
these surfaces.

CAUTION

CAUTION

WARNING

CAUTION

HOT SURFACE
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Equipment Damage: Do not disconnect the AC power to the analyzer, vacuum line, or 
the AC power to the external vacuum pump while analyzer is operating. Damage may be 
caused by current surges if power is applied while attaching or removing cables.

This analyzer weighs 47 lbs. (21.3 kg ). Use the technique described below when lifting 
the analyzer.

1. Before lifting, inspect the unit for slippery substances or sharp edges.

2. Lift with two people, one on each side of the analyzer.

3. Crouch down and stay close to the unit. Always keep your back as straight as 
possible. 

4. Position your feet for sturdy balance. Lift with your legs, not your back. 

5. Do not twist the back while carrying the unit. Rotate direction with hip joints. 

6. Lower the unit by bending at the knees.

2.3   Laser Safety

This equipment is classified as a Class 1 laser product with an embedded 3B laser in 
accordance with EN 60825-1:2014. Do not to open the enclosure where this label is 
placed; there are no user serviceable parts inside.

The following laser safety Label is affixed to the outer cover of the analyzer.

Figure 5 - Laser Safety Label – Affixed to Outside Cover of Analyzer

CAUTION

WARNING

WARNING
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The laser is a Class3B when exposed. 
Only operate or service this device in accordance with the instructions in this guide, and 
only open the device in an approved laser safe service area using appropriate laser-
safety glasses.

The following laser safety label is affixed to the inside of the analyzer: 

Figure 6 - Laser Safety Label – Affixed to Inside of Analyzer

Use of controls or adjustments or performance of procedures other than those specified 
herein may result in hazardous radiation exposure.

Any light emitted from the front panel status indicator, regardless of color or state, 
indicates one or more lasers are on.

WARNING

WARNING

WARNING
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3 Unpacking

3.1   Inspect the Shipping Containers
Picarro products are inspected and tested before leaving the factory. Their packing 
containers have been designed to keep the equipment safe from damage during transit.

Picarro shipping containers consist of:
 l A wooden crate with metal clamps
 l Layers of protective foam

Figure 7 - Shipping Container with Clamps Installed/Removed

1. To open the crate, use a claw hammer to remove the metal shipping clamps.

2. Inspect the condition of the crate and packing materials upon arrival. The crate houses 
the analyzer and the external pump. Even if the crate shows some external damage, it will 
protect the instrument under most circumstances.

If the equipment inside the container does appear to be damaged, photograph all the 
evidence of damage and contact Picarro, sending the photographs as soon as possible.

3. Keep all packing materials so the instrument can easily be returned Picarro if necessary.

3.2   Unpack Components
While unpacking each shipping box:
 l Inspect each item to ensure it is not damaged. 
 l If items are missing, contact Picarro.
 l Keep the shipping materials to reuse when transporting the analyzer.
 l Contact Picarro for options on transporting systems to remote labs.
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This analyzer weighs 47 lbs. (21.3 kg). Use the technique described below when lifting 
the analyzer.

1. Before lifting, inspect the unit for slippery substances or sharp edges.

2. Lift with two people, one on each side of the analyzer.

3. Crouch down and stay close to the unit. Always keep your back as straight as 
possible. 

4. Position your feet for sturdy balance. Lift with your legs, not your back. 

5. Do not twist the back while carrying the unit. Rotate direction with hip joints. 

6. Lower the unit by bending at the knees.

3.3   Contents

The following shipping contents may arrive in one or more shipping containers.

Table 3 - Shipping Contents

Part (qty) Description

Analyzer (1)

Includes all the data acquisition, control, and 
communications hardware and firmware to perform all gas 
handling, spectral collection, and analysis.

AC Power Cables (1)

A power cable with connectors appropriate to your country 
is provided. Note: The analyzer automatically adjusts to 
local voltage. 

WARNING

NOTE
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Part (qty) Description

Control Cable Kit (1)

For external solenoid valves.

Nut (1) and Ferrules (2)

For connecting input line to analyzer gas input.

Vacuum Hose (1)

Hose to connect the pump to the analyzer.

Rails (1 set)

Mounting rails for cabinet installation.

Keyboard and Mouse (1)

Monitor is not included.
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Part (qty) Description

Document Packet (1)

Includes this user manual and certificate of compliance (not 
shown).

A2000 Vacuum Pump (1)

Provides vacuum required for sample gas sequencing into 
and out of the analyzer.

AC Power Cable (1)

A power cable with connectors appropriate to your country 
is provided. 

Note: The vacuum pump voltage must be selected. See  in 
section . 

Pump Manual (1)

Detailed instructions for pump.
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4 Hardware Setup
Read this entire section before proceeding. Refer to Figure 17 in the following section for 
installation.

4.1   Required Components and Tools
 l 9/16" open end wrench
 l 11/16" open end wrench
 l 5/8" open end wrench
 l Phillips head screwdriver (for rack mounting)
 l 2.5 mm Allen wrench (for rack mounting)
 l Pump
 l Power Cord for analyzer and pump

4.2   Installation Safety

Two-person lift required: The analyzer weighs 21.3 kg (47 lbs). When lifting the analyzer, 
use the technique described 2.2 General Safety (or follow your local regulations). 

When the analyzer is being integrated to an external system, the safety of that system is 
the responsibility of the assembler of that system. 

Equipment Damage: Do not attach electrical power to or start the analyzer until after 
attaching and turning on the External Vacuum Pump. Do not disconnect the vacuum line 
while the analyzer is running. Failure to do so could result in damage to the optics.

Picarro sells certain USB enabled devices, such as GPS, which are approved for use. Do 
not connect USB hubs or unauthorized USB devices (except flash drives, mice, and 
keyboards) to the USB ports. Unauthorized USB devices may interfere with the normal 
functioning of the analyzer.

WARNING

CAUTION

WARNING

WARNING
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When using compressed gases, follow all appropriate safety conventions, including use 
of eye protection, physical restraint of cylinders, etc.

Lines connected to the 1/4” Swagelok sample inlet connector must not exceed 15 PSIG 
of pressure.

Operating at concentrations above the intended ranges may render the instrument 
unsafe to operate, maintain, service or dispose of.

Any light emitted from the front panel Status Indicator, regardless of color or state 
indicates one or more lasers are on.

During installation, do not position the analyzer so that it is difficult to operate the 
electrical disconnecting device (such as an emergency off (EMO) switch or breaker).

If mounting in a 19” rack, this analyzer cannot support itself using a front rack mount kit 
alone. It must be supported by a shelf, or by user-provided “L” type support brackets.

Use the AC power cables supplied with the analyzer or a similarly rated cable. Check 
with Picarro technical support if you have questions about power cable replacement. An 
inadequately rated power cable can result in equipment damage.

WARNING

WARNING

WARNING

WARNING

CAUTION

WARNING

CAUTION
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Cords shall be rated for the maximum current for the equipment and the cable used shall 
meet the requirements of IEC 60227 or IEC 60245. Cords certified or approved by a 
recognized testing authority are regarded as meeting this requirement. The connector 
type used should be: IEC320 C13.

If the analyzer has been stored at less than 10 °C, allow the components to equalize to 
room temperature before starting the installation process.

Equipment Damage: It is imperative that the analyzer have adequate ventilation and/or 
cooling to maintain the ambient temperature below 35 °C when operating. Do not place 
the pump or the instrument in any enclosure without providing adequate forced air flow.

Do not plug or block any perforations in the chassis of the instrument. Do not put 
anything near the instrument that will impede the air flow. Failure to provide adequate 
airflow, especially clearance at the front and rear panels, to ensure proper airflow and/or 
cooling to the analyzer will result in overheating of the analyzer causing a shutdown and 
potential damage. There should be 6” (15 cm) of clearance in the front and back of the 
analyzer.

CAUTION

CAUTION

CAUTION

CAUTION
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To determine if the ventilation is adequate in an enclosure, monitor the temperature of 
the air near the instrument and adjust ventilation so that the ambient temperature is 
within specification. As a guide, the ambient temperature of the air around the 
instrument cannot exceed the specifications listed below.

Thermal 
Specifications

Min Max Description

Ambient Operating 
Temperature

Worst-case environmental limits 
(unless otherwise specified)

4.3   Analyzer Preparation

4.3.1 Ventilation Considerations
The instrument and pump require adequate ventilation in order to function properly. Do not 
plug or block any perforations in the chassis of the instrument. Don’t place anything near the 
instrument that will impede the air flow. 

4.3.2 Positioning

The unit is shipped with rubber feet installed for benchtop use. Alternatively, it can be 
mounted in an equipment rack using the drawer-style rails included in the shipping 
crate. If the rails are used, the rubber feet must be removed so the unit can fit in a 
standard 5U rack opening. For instructions, see 4.5 Rack Mount Instructions

1. Remove the analyzer and the external vacuum pump from the shipping container.

2. Install the analyzer in a rack or place it on a cart or table.

If you rack-mount the analyzer, be sure to support it with a shelf or the provided rails; 
the analyzer cannot support itself on the front rack mounting brackets alone.

3. Place the external vacuum pump near the analyzer in a rack, or on a cart or table.

CAUTION

NOTE

CAUTION
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4. Unpack the analyzer accessories (vacuum line, cable kit, manual, and certificate of 
compliance).

Store the certificate of compliance in a safe place. It may be required if you contact 
Picarro for service or questions.

5. Remove the caps from the analyzer Sample inlet and Vacuum connection ports. 

6. Remove the caps from the pump vacuum inlet. Save the caps for reuse in case the 
analyzer and pump is stored, moved, or shipped.

4.3.3 Set A2000 Pump Input Voltage
1. If using an A2000 vacuum pump, set its input voltage to the correct level for your area by 

rotating the voltage selector switch located on the side of the pump next to the fuse 
holder.

Fuse

Input Voltage Selector

Figure 8 - Vacuum Pump Voltage Selection

4.4   A2000 Pump and Gas Inlet Connections
Follow instructions in this section when using an A2000 pump with your analyzer.

4.4.1 Pump Connections
Refer to the following figure when using an A2000 pump with your analyzer.

NOTE

1

2
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Figure 9 - Analyzer Setup with A2000 Pump

When working with hazardous gases, remove the pump exhaust muffler and adapt a 
tube to the vacuum pump exhaust port (shown in the above figure) and direct the 
exhaust to a safe place for venting the mixture of sample gases. For instructions, see 
Chapter F, Setting up Contained Exhaust Flow.

1. Connect the provided vacuum line between the analyzer port labeled VACUUM and the 
pump vacuum inlet. 

2. If working with hazardous gases, see Chapter F, Setting up Contained Exhaust Flow for 
instructions on directing the pump exhaust to a safe venting environment.

4.4.2 Sample Gas Inlet Connections 
There are two types of sample Inlet connections which are model-dependent. 
 l Analyzers that have stainless steel (SST) sample inlet connectors.
 l Analyzers that have PFA sample inlet connectors.

CAUTION
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4.4.3 Sample Gas Inlet Connection (SST Tubing)
1. Use 1/4” OD SST tubing and connector sets to connect from sample source to the 

sample inlet.

2. Place the two ferrules inside the nut as shown below.

Figure 10 - Orientation of Inlet Nut and Ferrules (SST Tubing)

3. Loosely connect the nut to the INLET on the back panel of the analyzer, being careful not 
to let the ferrules fall out.

4. Insert the tubing into the back of the nut and through the ferrules, feeding it in as far as 
possible without deforming the tubing.

5. Hand tighten the nut.

6. Using a 9/16" wrench (not included), tighten the nut 1-1/4 turns.

When reconnecting SST tubing

7. Inspect the ferrules. If you see any damage, replace the ferrules and follow the directions 
above for making a new connection.

8. If there is no damage, hand tighten the connector to the analyzer sample inlet.

9. Using a 9/16" wrench, tighten the nut 1/6 of a turn (60°).

4.4.4 Sample Gas Inlet Connection (PFA Tubing)

When making a new PFA gas inlet connection: 

1. Use 1/4” OD PFA tubing and connector sets to connect from sample source to the 
sample inlet.

2. Place the two PFA ferrules inside the PFA nut as shown in the following figure.

Figure 11 - Orientation of Inlet Nut and Ferrules (PFA Tubing)

3. Loosely connect the nut to the INLET on the back panel of the analyzer, being careful not 
to let the ferrules fall out.
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4. Insert the tubing into the back of the nut and through the ferrules, feeding it in as far as 
possible without deforming the tubing.

5. Hand tighten the nut.

6. Using a 5/8" wrench, tighten the nut 1-1/6 turns (1 full turn plus another 60°).

When reconnecting PFA tubing:

1. Inspect the ferrules. If you see any damage, replace the ferrules and follow the directions 
above for making a new connection.

2. If there is no damage, hand tighten the connector to the analyzer sample inlet.

3. Using a 5/8" wrench, tighten the nut 1/6 of a turn (60°).

4.5   Rack Mount Instructions
SI and PI series analyzers can be mounted in a standard 5U rack opening using slide rails or 
rack mount kit using additional shelf to support the weight of the analyzer. Use one the 
following procedures for the desired mounting configuration.

4.5.1 Rack Mount (Slide Rails)
Follow these instructions to mount the analyzer using slide rails.

1. Remove the rack-mounting rails from shipping crate and remove packaging.

2. Extend each rail. Press the blue PUSH HERE button and remove the narrow inner slide 
from the assembly.
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Press to Release

Inner Slide

Figure 12 - Inner Rail Slide Removal

3. Attach the inner slide to side of the analyzer as shown in the following figure using four 
included M4 x 8 button-head screws.

4. Repeat on the other side of the analyzer.

Figure 13 - Attaching Inner Slide Rails to Analyzer

5. Attach a front panel restraint (locking bracket) to each side of the analyzer using two 
included M4 x 8 button-head screws.

1

2
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Front Panel Restraint

Figure 14 - Front Panel Restraint Installed

6.  Mount the outer rails to the rack using supplied hardware at each end, or according to 
rack design.

Figure 15 - Outer Rail Mounted to Rack

1
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Equipment racks vary, and some customization may be necessary.

7. Remove the rubber feet from the analyzer using a Phillips screwdriver. This may be 
necessary to prevent clearance issues with adjacent instruments within the rack.

Two-person lift required. This analyzer weighs 47 lbs (21.3 kg) When lifting the 
analyzer, use the technique described in the Safety section of this document (or 
follow your local regulations) .

8. Use two  people to lift the analyzer, engage the inner rails on analyzer with outer rails in 
rack, and slide analyzer into place. Then secure the front panel restraints (Figure 14) to 
the rack frame.

4.5.2 Rack Mount (Mount Kit)
Follow these instructions to mount the analyzer using the mount kit.

If mounting in a 19” rack, this analyzer cannot support itself using a front rack mount kit 
alone. It must be supported by a shelf, or by user-provided “L” type support brackets.

1. Using the mount kit, attach a front panel restraint (locking bracket) to each side of the 
analyzer using two included M4 x 8 button-head screws.

NOTE

WARNING

WARNING
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Front Panel Restraint

Figure 16 - Front Panel Restraint Installed

2. Install the additional user supplied shelf or "L" brackets to support the weight of the 
analyzer as recommended. 

3. Use two  people to lift the analyzer into place. Then secure the front panel restraints 
(Figure 14) to the rack frame

If needed, perform any additional steps to secure the analyzer per the user supplied 
support guidelines.

4.6   Electrical Connections 
 Refer to the following figure for connection points.

This section is designated as Electrical Safety Task Type 2: Equipment is energized. 
Energized circuits are covered or insulated.

1

NOTE

NOTE
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External Vacuum Port to Vacuum 
Pump

Gas Inlet PFA Fitting

4–20 mA Signal Output

USB for Logic Board (Not connected)

Analog EIC Output (Optional upgrade)

COM 3 Port (Connected but typically 
not used)

DIO (Only for PAL autosamplers; not 
used with this instrument; not 
connected)

Valve Control Port (Solenoid valves)

AC Power Input and Power ON Switch

Audio In/Out Ports

Ethernet Ports – RJ-45 (2 ea)

USB Ports (2 ea)

DVI-D Video Monitor Port

COM 1 Port

USB Ports (4 ea)

Display Port

DVI-D Video Monitor Port (typical)

COM 2 Port (Rotary valve – A0311, 
A0311-S)

Figure 17 - Rear Panel Diagram

1. Connect a monitor to the HDMI port at the back panel. The analyzer will detect the 
connection and adjust the resolution to match the monitor.

2. Connect a mouse and keyboard to a pair of USB ports.

3. Connect the provided AC power cable from the analyzer to the power source.

1

2

3

4

5

6

7

8

9
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14

15

16

17

18
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The analyzer has a universal power supply that automatically adjusts to power 
sources ranging from 100-240 VAC, 50/60 Hz, 10 A max.

The A2000 pump does not automatically adjust to power sources. If using the A2000 
vacuum pump, ensure its input voltage is set to the correct level for your area by 
rotating the voltage selector switch located on the side of the pump next to the fuse 
holder (see Figure 6).

4. Check that the A2000 pump voltage input switch is set correctly.

5. Connect the provided AC power cable from the vacuum pump to the power source.

6. If used, connect the valve cable from the analyzer back panel to any solenoid valves.

7. If used, connect rotary valve (A0311 or A0311-S) to COM2 with its provided serial cable.

NOTE

NOTE
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5 Analyzer Basic Operation
This section explains how to operate the analyzer using the GUI. It describes system startup, 
shutdown, and recovery procedures, desktop features. GUI Functions are detailed in section 
Chapter 6, GUI Functions.

Using this analyzer in a manner not specified by Picarro may result in damage to the 
analyzer and render it unsafe to operate.

During operation, do not position the analyzer so that it is difficult to operate the 
electrical disconnecting device (such as an emergency off (EMO) switch or breaker).

The illustrations shown in this chapter are for example only. What is shown on your 
instrument is dependent on the model analyzer in use and may differ.

5.1   Startup
1. Make sure the pump vacuum hose is connected between the analyzer and pump.

Always turn on the external pump before powering up the analyzer. This ensures a 
safe start-up sequence.

2. Verify the power cable to vacuum pump is plugged in.

3. Switch power on at the pump.

4. Verify the power cable to the analyzer is fully inserted into the power receptacle.

5. At the analyzer back panel, press the main power switch to the ON ( I ) position.

6. If needed, press the round Soft Power button on the rear panel. The LED indicator 
illuminates green. See 1.1.1 Analyzer .

WARNING

CAUTION

NOTE

CAUTION
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The Picarro Launch Pad user interface displays and the CRDS Data Viewer (Figure 18) 
automatically starts within 30 seconds. For more information about the CRDS Data 
Viewer features, see Chapter 6, GUI Functions.

The analyzer will not begin producing data until the cavity temperature and pressure have 
reached their operational set points. A message will display in the Status Log window (Figure 
18, bottom panel) when each set point is reached. An explanation of the most common 
status log messages can be found in 6.10 Measurement Status Log.

Data is saved automatically whenever the analyzer produces data. The data displayed on the 
CRDS is the continuous real time read-out from the analyzer. A user-relevant subset of this 
data is stored in:

where Y = year, M = month, D = day. For more information see, .

In order to measure discrete samples (such as individual gas bags) or from multiple locations 
(when switching valves draw in ambient air from different heights) a separate software 
window (coordinator) is used to control the sample source and match the corresponding real 
time read out with the sample source. Depending on system configuration, coordinator 
programs may not be included.

Figure 18 - CRDS Data Viewer Screen

5.2   Shutdown 
This section describes how to safely shutdown the analyzer using dry gas, closing the CRDS 
application, and powering off the instrument from the Picarro Launch Pad.
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A flow of clean, dry gas should always be directed to the instrument for several minutes 
prior to shutting down. Trapping a high-moisture content gas sample in the cavity can 
cause condensation damage to the mirrors as the instrument cools from its operating 
temperature.

Do not turn off the pump or disconnect the vacuum line while the instrument is 
operating.

1. With the pump still running, switch to a source of clean, dry gas at the sample inlet and 
allow it to run until the water channel reading on the GUI falls below 2000 ppm. This will 
prevent any damage from condensation to the cavity surfaces. This dry gas may be from 
a tank (target 2-3 PSIG pressure) or from a desiccant column like the DrieRite column, 
C0360, sold on store.picarro.com).

2. From the CRDS Data Viewer select the Quit button located in the lower left corner of the 
window.

3. A message displays prompting the user to confirm the shutdown. Once confirmed, the 
CRDS Data Viewer turns off.

Note you must be logged in to shut down the analyzer.

Figure 19 - Stop Data Acquisition Confirmation

4. From the Picarro Launch Pad select Power Off to tun off the hardware.

5. Manually turn off the pumps and dry gas only if system requires it.

CAUTION

CAUTION

NOTE

https://store.picarro.com/
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Leave any dry gas or desiccant attached to the inlet during this process.

6. When the instrument fans audibly turn off, and when the green power button light on the 
front of the instrument turns off, shut off the pump manually from the rocker switch 
located on the pump.

5.3   Analyzer Restart after Electrical Power Outage
If power to the analyzer is cut-off for any reason the analyzer will cease operation. However, 
when the power is reapplied, the analyzer will restart automatically, the Picarro software 
tools will properly close out previous files and open new files for data collection so that 
previously collected data, instrument diagnostics and other parameters recorded up to the 
time of power outage are retained. 

If short power outages are common in the user location, Picarro recommends using an 
uninterrupted power supply (UPS) to protect the data stream and the health of the cavity. 

5.4   Picarro Launch Pad
The Picarro Launch Pad is the entry point for starting and using the analyzer. It provides 
access to the CRDS Data Viewer, tools, settings, and administrative controls for the 
instrument such as managing user accounts. This section provides an overview of the 
Picarro Launch Pad’s key features with additional information throughout this manual.

Picarro Launch Pad features vary depending on user account types. Each section 
describes the account type that is required for each of the main menu options.

5.4.1 Home Menu
Account Type: All Users

The Picarro Launch Pad automatically starts in Guest account mode and displays the home 
menu upon startup of the analyzer. Note several options are not accessible until you login 
with a user account. The Home menu options are provided, as shown in the following figure.

NOTE

NOTE
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Figure 20 - Picarro Launch Pad/Home Menu

 l H2O2 – Starts the analyzer and launches the CRDS Data Viewer.
 l DatViewer — When clicked, a window opens that allows you to convert between *.dat and 

H5 data files and to make various graphical representations of your data over time periods 
longer than what is available in the software buffer. The instructions on using the Data File 
Viewer software are described in Chapter E, Data File Viewer. Note requires login to the 
Picarro Launch Pad.

 l Log In — Provides access to the Picarro Launch pad and tools associated with a 
specified user account. 

Note options vary with different types of user accounts.

NOTE
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 l Profile — Provides access to the User Management Tool to allow regular users to change 
their own password and administrators to manage user accounts.
Log Out — Concludes the user account session.

Requires a password to obtain entry. For more information, see 7.4 Viewing My 
Profile and 7 User Management.

5.4.2 Tools Menu
Account Type: Operators, Technicians, and Administrators

The Tools menu provides additional utilities for the instrument and include the following 
options as shown.

Figure 21 - Picarro Launch Pad/Tools Menu

NOTE
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 l l Copy Files — Allows data to be copied to an external device. Requires technician or 
administrator permissions.

 l User Calibration — Provides Picarro Data Recalibration tool to adjust slope and intercept 
of concentration calibration.

 l Flow Controller — View and configure flow controller for desired gas flow rate.
 l Ringdown Viewer — Provides visual ring-downs for evaluation of CRDS operations.

Controller — Displays the Cavity Ring-Down Spectrometer Controller to view technical 
information about the analyzer operation.

 l Support Export — Opens the CRDS Diagnostic Data Collector tool to curate support data 
for troubleshooting.

File Manager (Copy Files)

1. On the home page, click on Files.

2. From the Picarro Launch Pad, click on the Tools menu and Copy Files button.

3. Login using user credentials.

4. Plug in an external USB drive.

5. In the bottom right-hand corner, select mount and choose the desired drive. After 
selecting, files will be populated on the right side with from the USB drive

6. Using the upper left-hand corner drop down menu, select the type of file: Data, 
Screenshot, User History, Validation Report.

7. Highlight and select the desired files.

8. Click Copy to copy or move to transfer file to USB drive.

9. Unmount the USB drive when file transfer/copy is complete.

Figure 22 - Transfer Files Dialog
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5.4.3 Settings Menu (Setup Tools)
Account Type: Technicians and Administrators

The Settings menu provides various configuration options for the analyzer and is described 
in detail in Chapter B, Setup Tools and Communication.

5.4.4 Administration Menu
Account Type: Administrators

The Administration menu provides the following options.

Figure 23 - Picarro Launch Pad/Administration Menu

 l Windowed Mode — Displays the Picarro Launch Pad and utilities as windows within the 
user interface.

 l Network — Provides configuration of network settings.
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 l Clock — Sets the time of the hardware clock.

The clock, date, and network settings are not accessible if the instrument is running. 
Use one of the following procedures to access these settings.

Option 1:
You can access the clock and other system settings when starting the analyzer and 
logging in within 30 seconds of the Picarro Launch Pad Home screen appearing. This 
will pause the automatic launch of the drive. After configuring the settings, return to 
the Home screen to start the analyzer.

Option 2:
If the instrument is running, users can access the clock and other system settings by 
selecting Shift (keyboard) + Quit button from the CRDS Data Viewer Screen. This 
action will stop the software and driver, allowing access to the settings. Note: 
Disabling the driver is necessary only to access the clock settings. Using the Quit 
button alone is sufficient to access other system settings, and it is recommended to 
keep the driver running whenever possible.

 l Set Mode — Sets the mode of operation to Research or Compliance. For more 
information, see the following section 5.4.5 Research and Compliance Modes.
System Backup — A mechanism for backing up or restoring system settings.

 l Launch Shell — Opens a command line interface.
 l TeamViewer — Allows access to control the analyzer from another computer enabling 

remote work. For more information, see H Remote Analyzer Access.
 l Toggle Modbus — Allows enabling and disabling of the Modbus interface for 

configuration of the communication protocol.

5.4.5 Research and Compliance Modes
The PI2114 analyzer operates in two primary modes: Research Mode and Compliance 
Mode. Each mode enables specific functions designed to match the requirements of its use 
case. Certain features are common to both modes, while others differ depending on the 
operating environment.

Research Mode

When operating in Research Mode, the following additional options are available:

CRDS Tools Menu
 l User Calibration — Allows the user to perform system calibration.
 l Data Log Files — Provides access to stored data logs.

NOTE
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 l Show Valve Sequencer GUI — Opens the graphical interface for valve sequencing.

Picarro Launch Pad
 l DatViewer — Enables review and analysis of .dat files.

Compliance Mode

When operating in Compliance Mode, the following differences apply:

Picarro Launch Pad
 l Copy Files — Used to export data in both .dat and .pdf formats.

PDF generation is not available in Research Mode, as it can reduce system 
performance.

Features Common to Both Modes

Regardless of whether the system is running in Research or Compliance Mode, the following 
rules apply:

User Calibration
 l May also be launched from the Picarro Launch Pad.
 l Requires user authentication before a new calibration can be applied.

User Action Logging
 l All user actions are logged in both modes for traceability and auditing.

NOTE
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6 GUI Functions
This chapter describes the GUI features of the CRDS Data Viewer. 

The illustrations shown in this chapter are for example only. What is shown on your 
instrument is dependent on the model analyzer in use and may differ.

6.1   GUI Overview
The features of the GUI as shown below are described in the following sections.

Users, View, Tools, 
and Help menus

Digital Readouts and 
Statistics

Data Source, Data 
Key, and Precision 
menus for data 
window content

Axis Auto Scaling

Reset Data Buffer

Instrument Status

Quit Button

Alarm Panel

Status Log Window

Data Windows

Figure 24 - CRDS Data Viewer GUI

NOTE

1

2

3

4

5

6

7

8

9

10
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6.2   Users, View, Tools, and Help Menus

Figure 25 - CRDS Toolbar Options

6.2.1 User Menu
 l User Login — Provides access to the CRDS Data Viewer. If you do not have an account 

one can be created by an administrator.
 l User Logout — Disables access to the CRDS Data Viewer functions. 

6.2.2 View Menu
The View menu provides the following options that can be enabled. Note that when toggled 
on, a check mark displays to indicate the enabled feature.
 l Lock/Unlock time access when zoomed — When locked, forces the data windows to 

display the same time scale during zoom.
 l Statistics — Toggles the measurement statistics display, see the 6.4 Digital Readouts.
 l Instrument Status — Toggles the instruments status display. See the 6.5 Instrument 

Status.
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 l Graph — Set the desired number of line graphs to be visible on the CRDS Data Viewer. 

Figure 26 - Configure Graph Window

The data buffer resets when the number of graphs are changed.

6.2.3 Tools Menu
Use the Tools drop-down menu to plot data, copy data, perform user admin tasks, calibrate 
the instrument, or show/hide the valve sequencer GUI. The Tools menu features are as 
follows:
 l l User Calibration — Opens the password protected user calibration window (default 

password is picarro).
User Administration — Provides access to User Management options for managing user 
accounts, policies, viewing histories and profiles.

 l H2O2 Validation — Launches the System Validation window to allow testing of the 
instrument to determine if it is operating as expected. For more information, see 11 
Instrument Validation.

 l l Data Log Files — Copies data to an external drive using the File Manager.
 l Show Valve Sequencer GUI — Toggle to display the external valve sequencer window 

(use alt-tab to bring it to the front).

6.2.4 Help Menu
 l About — Displays the software release version of the instrument.

6.3   Alarms Panel
This panel is used to monitor the status of the internal instrument alarms. These indicators 
are gas concentration alarms, such as “N2O Too High/Low” depending on instrument 
configuration. The gas concentration alarm icons are off (grayed) when the respective 
concentrations are below a certain value, and they are illuminated red when the respective 
concentrations are above/below a certain value. 

NOTE
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High/low alarm settings are not intended as a safety measure as configured at the 
factory, either with respect to human health or the health of the analyzer. It is up to the 
customer to determine the meaning and level of a “high” or “low” value based on their 
application.

Figure 27 - Alarm Panel

Alarm Panel Indicators are colored as follows:

System Alarm:
 l Green when the analyzer is measuring properly
 l Flashing yellow when the analyzer is warming up
 l Yellow when not warming up properly
 l Red when not operating properly

Measurement Range Alarm:
 l Green when concentration is within analyzer measurement range
 l Red when above analyzer measurement range

Custom Range Alarm:
 l Green when within boundaries set by the user
 l Red when not within boundaries set by the user
 l Grey when alarm is disabled by the user (these are disabled by default)

To view the alarm set point, click on the Alarm Icon and a dialog box displays indicating the 
alarm setting and allows the user to enable it or change the setpoint.

CAUTION
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Figure 28 - Alarm Set Dialog

This feature allows reading or changing the alarm settings and the ability to enable it or 
change the set point. The indicator illuminates when the concentration goes above the set 
point and resets (indicator off) below the set point. The alarm modes for gases are:
 l Higher
 l Lower
 l Inside
 l Outside

Type the value you wish to set the alarm to and click the OK button or Cancel if you do not 
wish to change the alarm value. If you do nothing, the dialog box will disappear, and the 
alarm value will remain unchanged. The units are those that appear in the GUI graph. 

6.4   Digital Readouts
Displays the latest value recorded for the selected Data Key for each Data Window. 
Changing the Data Key changes the Digital Readout as well as the Data Window view.

If the Statistics entry is enabled in the View menu, the mean, standard deviation, and slope of 
the data in the graph is dynamically calculated and indicated below the digital concentration 
readout. These numbers change to reflect statistics of whatever data is in the data window. 
Zooming into a section of existing data will show the statistics statically for that time period, 
while the digital readout above the statistics continues to update with the latest value. See 
6.12 Graph Zooming and Panning for more information.
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With Show Statistics Enabled With Show Statistics Disabled

Figure 29 - Digital Readouts Panel

6.5   Instrument Status
If these parameters are enabled through the Instrument Status entry in the View menu on the 
main toolbar, digital readouts for Warm Box temperature, Cavity Temperature, Cavity 
Pressure, and Box Pressure are displayed below the digital readouts panel.

Figure 30 - Instrument Status Panel

6.6   Quit Button
Shuts down the analyzer. See 5.2 Shutdown .

Figure 31 - CRDS Quit Button

1 2
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6.7   Data Window
The data window displays a graph of any stream of data vs. system time, with a format of 
hh:mm:ss. The user can select which data streams are displayed using combinations from 
the Data Source and Data Key pull down menus. The precision displayed can be adjusted 
using the Precision menu. Auto-Scaling of the Y-axis is also available. Clicking any 
Autoscale button scales its Y-axis if the plot hasn’t done this automatically.

Source Keys

Data Keys

Precision

Auto Scale

Reset Buffers

Plot for Data Key 

Figure 32 - Data Window Panel 

6.8   Data Source and Data Key Pull Down Menus
Data Source and Data Key menus enables selection of the data stream that is viewed in the 
data window. 
 l Gas concentrations — If instrument Analysis (where instrument represents the system 

installed) is selected.
 l Sensor Readings — If Sensor is selected, the analyzer’s optical cavity pressure or 

temperature can be viewed, as well as the temperature of the electronics of the analyzer 
(“DASTemp”, not directly controlled), and the temperature of the analyzer’s wavelength 
monitor, indicated as “WarmBoxTemp.” 

Figure 33 - Data Source and Data Key Pull Down Menus

1

2

3
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6.9   Precision Pulldown Menu
Click on the pull-down to select the precision displayed on the y-axis; between 0 and 4 digits 
of precision or auto. The currently selected precision is displayed during operation. This 
does not affect the precision of the saved data in the data log files or results files. Auto 
precision is sufficient for nearly all applications.

Figure 34 - Precision Pull-down Pane

6.10   Measurement Status Log
This window displays instrument status messages, in the following form: 
YYYY-MM-DD HH:mm:ss, then Generic message text.

6.10.1 Common Status Log Messages
Following are the most common messages that appear:
 l Pressure Stabilizing/Locked — Displayed when the valve control system begins to allow 

flow through the analyzer and stabilizes the pressure inside the cavity.
 l Temperature Locked — WB: When the temperatures of the warmbox have stabilized. 

This is typically the longest step in the startup sequence. Startup: Depending on ambient 
temperature, the analyzer and its hotbox temperature set point, this step may take as little 
as 20, or as much as 60 minutes. Restart: If the instrument is only stopped briefly, this 
may take a few seconds to a few minutes.

 l Preparing to Measure — Spectral scanning has started. Concentration measurements 
will be available in approximately 30 seconds. The instrument will continue to scan and 
report concentration measurements until the instrument is shut down.

 l Measuring — This is the normal mode of operation after startup has completed.

Figure 35 - Measurement Status Log
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6.11   Reset Buffers Button
Click the Reset Buffers button to clear the internal data buffer of the GUI (this clears the 
current data traces from the graphs). This has the effect of clearing all data in the data 
window. Pressing this button has no effect on any of the data log files stored by the 
instrument.

6.12   Graph Zooming and Panning

6.12.1 Zooming In/Out
To zoom in on a specific region of the graph, move the cursor to the area of interest, 
click/hold the left mouse button, then drag as desired to create a box that covers the region 
of interest. When the box is drawn, release the left button and the boxed area will 
automatically scale to fill the data window. 

Figure 36 - Data Graph Zoom Function

To zoom out to see all data in the buffer, double-click the left button within the graph display. 
To zoom out indefinitely, right click. Right clicking multiple times zooms out further. To auto 
scale the y-axis of either graph, use the Auto-Scale buttons as shown in the following figure.

To Zoom the X and Y axes: hold down the control button and move the cursor up/down or 
left/right using the right mouse button

Figure 37 - Auto-scale Buttons
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6.12.2 Lock/Unlock Time Axis
Zoom and pan features are often useful when time axes are locked, and the user wishes to 
align the Y axis in multiple plots. To lock or unlock the time axis of each graph during 
zooming, from the View menu, select Lock time axis when zoomed or Unlock time axis.

6.12.3 Panning
To pan the data in the X or Y axis: hold down the control button and drag the cursor using 
the left mouse button.
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7 User Management
User management includes:
 l Managing user accounts, such as adding users and changing passwords.
 l Setting user policies, such as password requirements and session duration.
 l Viewing and saving user histories.

There are three user roles defined in the system: operator, technician, and administrator. The 
permissions are as follows:

Table 4 - User Accounts and Functions

Function
Not 

Signed 
In

Operator Technician Administrator
Service 
(System 

Manager*)

View Data Viewer • • • • •

Set Alarms  • • • •
Configure Data 
Viewer (partial) 

 • • • •

Quit Measuring  • • • •
Quit (software 
shutdown)

 • • • •
Configure Data 
Viewer (full 
access)

   • • •

User Management    • • •
Software 
Management
(installation and 
uninstallation)

       •

*Contact Picarro support at support@picarro.com to obtain Service (System Manager) access.

User management settings are available from the Tools menu in the Data Viewer or by using 
the Picarro Launch Pad. Use one of the following procedures.

mailto:support@picarro.com
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From the Data Viewer:

1. From the Users menu, select User Login.

2. Login as an administrator (default user name is admin; default password is admin).

3. From the Tools menu, select User Administration to view the User Management a shown 
in Figure 38.

From Picarro Launch Pad:

1. Login to the Picarro Launch Pad as an administrator (default user name is admin; default 
password is admin).

2. Select Administration and User Accounts.

3. From the User Management Tool login as an administrator (default user name is admin; 
default password is admin).

4. The User Management window displays and has four tabbed states: User Accounts, 
User Policies, User History and My Profile.

Figure 38 - User Management Window

7.1   Managing User Accounts
The following features are available from the User Accounts tab and are further described in 
this section:
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 l Add new users
 l Disable users
 l Change user passwords
 l Change user roles

The default user names that are provided with the analyzer are tech, operator, and 
admin. The default passwords are tech, operator, and admin, respectively. User names 
and passwords are both case sensitive.

7.1.1 Changing a User Password
1. In the User Management window, click the User Accounts tab.

2. From the list of users, click the user you want to change and select the Edit User button. 
The user account information displays.

Figure 39 - Change Password

3. In the Password field, enter the new password.

Passwords are case sensitive. Additional rules for passwords can be set in the User 
Policies tab. For more information, see 7.2 Setting User Policies

4. In the Password Confirmation field, re-enter the password.

5. Click Save to save the password.

NOTE

NOTE
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To change your own password for your account, see 7.4 Viewing My Profile.

7.1.2 Changing a User’s Role
1. In the User Management window, click the User Accounts tab.

2. From the list of users, select the user you want to change and click the Edit User button.

3. From the Role field, select the new role and click Save.

The role is now changed to the desired setting.

Figure 40 - Change Roles

7.1.3 Disabling a User Account
Users cannot be deleted from the system, but they can be disabled to prevent access to the 
software. Use the following procedure to disable a user.

1. In the User Management window, click the User Accounts tab.

2. From the list of users, select a user name. 

3. Click Disable User; this will prompt you to confirm your choice.

4. Click OK to confirm the action.

NOTE
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Figure 41 - Disable Users

7.1.4 Adding a User
1. In the User Management window, click the User Accounts tab.

2. Click Add User; this will display the Add User screen.

Figure 42 - Add User
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3. Fill in the fields in the Add User window.

4. Click Save to open the New User Account dialog.

5. Review the user information and click OK to accept or Cancel to go back and edit the 
information.

7.2   Setting User Policies
1. In the User Management window, click the User Policies tab.

2. Make any changes. For more information, see the following 7.2.1 User Policy 
Descriptions.

3. Click Save. If you typed an incorrect value and want to undo any changes and revert 
back to the last saved configuration, click Revert.

Figure 43 - User Policies Tab

7.2.1 User Policy Descriptions
The following table provides descriptions for the various user policies.
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Table 5 - User Policies

Policy Description

Password 
length

Specify that the length of passwords (6–15 characters) or turn off the length 
requirement.

Password 
complexity

When selected, all new passwords must have at least one number, one 
letter, and one special character. This will not impact existing passwords.

Password 
expiration

When selected, any passwords that reach the selected maturity will expire. 
Any user signing in with an expired password will be required to create a 
new password.

Previous 
passwords 

When set, prevents a user from reusing a recent password. The system can 
remember up to 10 old passwords.

Limit login 
attempts

Tell the system to disable a user account after a set number of failed 
password attempts. The failed attempts are counted until the user 
successfully logs in. Once disabled, an admin will have to enable the 
account.

Lock 
session

When set, the system will automatically logoff any user after a set period of 
inactivity, requiring the user to sign in again.

Change 
password

Allows the user to change their own password.

Change 
phone 
number

Allows the user to change phone number and restrictions.

Change 
email

Allows user to change their email address.

Change 
name

Allows the user to change first and last name.

Save user 
actions

When enabled, user actions (such as logging in) will be saved in the User 
History.

7.3   Viewing User History
1. In the User Management window, click the User History tab to see a list of all the logged 

events.
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Figure 44 - User History Tab

2. Click the < and > buttons to navigate through the history (if the button is grayed out, then 
there are no additional pages).

3. To make sure the content is up to date, click Refresh.

4. To copy the user history onto a USB drive, click Download. This launches the File 
Manager, which will prompt to login. See  File Manager (Copy Files) for details on copying 
files from the analyzer.

7.4   Viewing My Profile
The My Profile tab provides information about the user that is currently logged into the 
system. The change password, phone number, email and name options are available to 
the user if these settings were enabled in the User Policies tab by an administrator. The 
user can use these options to edit their own profile information.
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Figure 45 - My Profile Tab
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8 File Management
The Picarro Analyzer generates ASCII-format text output files that are updated after each 
batch of concentration measurements is complete. The data files are stored primarily in 
DataLogger folders and are also mirrored in folders which retain more situational data. Some 
analyzers also produce discrete measurements stored in separate isotope data folders. All 
user data is archived, compressed, and retained, either shortly after the measurements or at 
a later point, to optimize space on the hard drive.

8.1   Data Archive 
The archive directory is:

/home/picarro/I2000/Log/Archive

This archive stores daily measurement and RDF data. Each folder is designated by date 
(YYYY-MM-DD) and has subdirectories:

DataLog_Private, DataLog_User, DataLog_User_Sync, EventLogs, and WBCAL.

The Data Logger files are in a simple text format (white-space delimited) with a DAT file 
extension. By default, each file stores one hour of data.

Certain instruments may contain additional sub-folders under: /Home/UserData relating to 
time synced file formats, soil flux, or GPS data, among others. If the user has any questions 
about this file structure, they can contact Picarro Support.

There are complete data files which include additional information beyond the concentration 
data including parameters such as instrument temperatures and pressure, set points and 
spectroscopic information. This information is generally not useful to the user, but can be 
useful for diagnostic purposes and is stored in the following directory:

/home/picarro/I2000/Log/Archive/yyyy-mm-dd/DataLog_Private

The archive files are in a HDF5 format, a more efficient data storing format with an .h5 file 
extension.

8.2   Data File Name
The file name is generated from the analyzer serial number, the date, and the time when the 
file was started. The specific time stamp depends upon the time the instrument was started 
and began measuring sample gas, so files seldom begin exactly at the top of the hour. For 
example:
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Instrument Serial Number

Date

Time (Local)

Figure 46 - Example Data File Name

 l NBDS2039: the analyzer serial number
 l 20250829: the date, in format yyyymmdd (to allow chronological sorting of data files).
 l 175334: the time the file was started in the computer’s local time 17:53:34, formatted as 

hhmmss using a 24-hour clock. Note that the time stamp of samples within the file is 
usually recorded in UTC (GMT) relative to the local time. For example, an analyzer in 
California will usually have a time stamp (UTC) within the file that is 8 hours ahead of the 
time stamp in the file name itself (UTC - 8). 

8.3   File Archiving
Picarro instruments will not delete data. Some instruments will, however, compress and 
archive older data to conserve hard drive space. Raw data file archiving frequency and 
details can be modified in the file: 

/home/picarro/I2000/AppConfig/Config/Archiver/Archiver.ini.

To avoid losing data, discuss with Picarro support before attempting any changes to the 
Archiver.ini file.

For each file type, there are various items along with some recommended default settings 
which may vary by file type:
 l Directory = /home/picarro/I2000/Log/Archive

Optionally specifies which directory to find files to archive.
 l MaxCount = -1

Specifies how many files to keep. A setting of -1 indicates that there is no maximum 
number of files. Generally, -1 is used in conjunction with a maximum size limit, below.

 l MaxSize_MB = 1500
Specifies that a maximum of 1.5 GB of data is to be kept before the system begins to 
archive old data.

1

2

3

CAUTION
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 l Compress = True/False
Specifies if archived files are to be zipped – recommended setting is true to save hard 
drive space. True means files are zipped, false means files are not zipped.

 l AggregationCount = 0
If compression is set to TRUE, specifies how many files to be included in each zip archive.

 l StorageMode = FIFO
First in first out. Specifies that old data is archived first.

 l Quantum = 4
Generally, should not be changed. Specifies the files to be sorted by year\month\day\hour 
in the archived directory structure.
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9 Modbus Communication
Modbus is a client/server data communication protocol to support communication to and 
from multiple devices connected to the same cable. Modbus can be configured for TCP/IP 
on port 50500 or RTU utilizing the analyzer’s COM1 port. See the following section on how to 
configure Modbus communication. 

9.1   Configuring Modbus Communication
1. From the Picarro Launch Pad, select Config followed by the Modbus button to configure 

the Modbus server as shown in the following figure.

Note the Config menu requires login to access the configuration menu. Log in with a 
user name and password.

Modbus button

Figure 47 - Settings/Modbus Configuration

This displays the Modbus Settings window shown in Figure 48. 

NOTE

1
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Figure 48 - Modbus Settings Window

2. From the Modbus Settings window the following configuration options are available:
 l Slave ID — The analyzer’s Slave ID.
 l Modbus Type — The Modbus Communication Protocol: TCP/IP or RTU. For more 

information, see section 9.2   Modbus Data Registers Overview and Setup.
 l TCP Port — Designates the TCP port if TCP/IP is selected.

Additionally, the window displays the CommandInterface Status. However, if Modbus 
Type is set to RTU, then the CommandInterface on COM 1 is disabled.

9.2   Modbus Data Registers Overview and Setup
This section describes the basic types of MODBUS data registers and setup information. 

Table 6 - MODBUS Register Types

Name Size Access

Input Register 16 bits Read-only

Holding Register 16 bits Read-write

Discrete Input 1 bit Read-only

Coils 1 bit Read-write
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9.2.1 Modbus TCP Setup Notes
 l MODBUS is configured for TCP/IP on port 50500.
 l When MODBUS is configured on port 50500, communication is also possible via port 502.
 l If MODBUS is configured as TCP/IP and the IP address of analyzer is changed, the user 

needs to restart the host application to run MODBUS with the updated IP address. 
 l MODBUS over TCP/IP does not support privileged ports (0 to 1023), except for port 502.

9.2.2 Modbus RTU Setup Notes
 l MODBUS RTU uses the analyzer’s COM1 port.
 l To establish connection between master and slave over MODBUS RTU, user needs to 

establish connection using "Straight Through Cable”. 
 l When MODBUS is configured for RTU, CommandInterface on COM1 is disabled. 

9.3   Modbus Register Maps
 l Data returned is in big endian format if it utilizes more than one Modbus register. 
 l If input register functionality is not available for a given analyzer type, the instrument will 

return value as “NaN” for float values and “False” for 1-bit registers.
 l Memory map is continuous memory. If a user tries to read a register address for which 

functionality is not available, it will return “0”. For example, reading address “0” for coil 
registers returns “0” since the address does not exist.

 l If a user tries to read a register address outside of maximum register memory map, the 
request will return an exception. For example, reading address 156 for coil register will 
return exception code “0x02” (Illegal address). 

 l System time is in milliseconds since 0001-01-01 AD.

9.4    Input Register Map
Most of the readings in the Picarro analyzer are the float type and need 32-bit data. Each 
parameter utilizes two registers, out of which the first one stores the MSB and the second 
stores the LSB of the float number.

Table 7 - Input Registers

Address Description Units Type Comments

1-6 Time stamp   String
Long value return as 12byte string.  
Date will be in format 
YYMMDDHHMMSS

7-8
H2O2 
Concentration 

ppb Float  
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Address Description Units Type Comments

9-10 H2O2_ID Unitless Float
Gas ID code 14 identifies gas at  
register 7 as H2O2

11-12
H2O2, 30sec 
trailing average

ppb Float

13-14
H2O2, 2min 
trailing average

ppb Float

15-16
H2O2, 5min 
trailing average

ppb Float

17-18
H2O2, max (full 
scale range)

ppb Float Value is 100,000 ppb or 100 ppm

19-20 H2O2, min ppb Float Value set to 0 

21-22
Concentration 
of H2O

% Float
Water is measured in absolute %, 
not  to be confused with relative 
humidity

23-24 H2O_ID Unitless Float
Gas ID code 00 identifies gas at  
register 20 as H2O

25-26
H2O, 30sec 
trailing average

ppm Float

27-28
H2O, 2min 
trailing average

ppm Float

29-30
H2O, 5min 
trailing average

% Float

31-32
H2O, max (full 
scale range)

ppm Float Value is 50,000 (5%)

33-34 H2O, min ppm Float Value is set to 0

35-36
Concentration 
of CH4

ppb Float  

37-38 CH4_ID Unitless Float
Gas ID code 04 identifies gas at  
register 34 as CH4
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Address Description Units Type Comments

39-40
CH4, 30sec 
trailing average

ppb Float

41-42
CH4, 2min 
trailing average

ppb Float

43-44
CH4, 5min 
trailing average

ppb Float

45-46
CH4, max (full 
scale range)

ppm Float Value is set at 200 ppm

47-48 CH4, min ppm Float Value is set at 0

49-50 Reserved      

51-52 Reserved      

53-54 Reserved      

55-56 Reserved      

57-58 Reserved      

59-60 Reserved      

61-62 Reserved      

63-64 Reserved      

65-66 Reserved      

67-68 Reserved      

69-70 Reserved      

71-72 Reserved      

73-74 Reserved      

75-76 Reserved      

77-78 Reserved      

79-80 Reserved      

81-82 Reserved      
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Address Description Units Type Comments

83-84 Reserved      

85-86 Reserved      

87-88 Reserved      

89-90 Reserved      

91-92 Reserved      

93-94 Reserved      

95-96 Reserved      

97-98 Reserved      

99-100 Reserved      

101-102 Reserved      

103-104 Reserved      

105-106 Reserved      

107-108 Reserved      

109-110 Reserved      

111-112 Reserved      

113-114 Reserved      

115+116 Reserved      

117-118 Reserved      

201-202 Cavity Pressure Torr Float  

203-204
Cavity 
Temperature

deg C Float

206-207
DAS 
Temperature

deg C Float

207-208
Etalon 
Temperature

deg C Float
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Address Description Units Type Comments

209-210
Warm Box 
Temperature

deg C Float

211-212 Outlet Valve
dig 
counts

Float

213-214
Instrument cal 
slope, H2O2

  Float

215-216
Instrument cal 
offset, H2O2

  Float

217-218
User cal slope, 
H2O2

  Float

219-220
User cal offset, 
H2O2

  Float

221-222
Instrument cal 
slope, H2O

  Float

223-224
Instrument cal 
offset, H2O

  Float

225-226
User cal slope, 
H2O

  Float

227-228
User cal offset, 
H2O

  Float

229-230
Instrument cal 
slope, CH4

  Float

231-232
Instrument cal 
offset, CH4

  Float

233-234
User cal slope, 
CH4

  Float

235-236
User cal offset, 
CH4

  Float

237-238 Reserved      

239-240 Reserved      
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Address Description Units Type Comments

241-242 Reserved      

243-244 Reserved      

245-246 Reserved      

247-248 Reserved      

249-250 Reserved      

251-252 Reserved      

253-254 Reserved      

255-256 Reserved      

257-258 Reserved      

259-260 Reserved      

261-262 Reserved      

263-264 Reserved      

265-266 Reserved      

267-268 Reserved      

269-270 Reserved      

271-272 Reserved      

273-274 Reserved      

275-276 Reserved      
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Address Description Units Type Comments

387 Error Code   int

Error for each control command of  
COIL
 l NO_ERROR = 0
 l ERROR_HANDLER_ERROR = 1
 l ERROR = 2
 l NO_SUDO_USER_PRIVILEGE = 3
 l NO_USER_EXIST = 7
 l USERNAME_PASSWORD_

INCORRECT = 9
 l USER_DISABLED = 10
 l ADMIN_RIGHT_REQUIRES = 11
 l PASSWORD_LENGTH_ERROR = 

12
 l PASSWORD_FORMATE_ERROR 

= 13
 l PASSWORD_REUSE_ERROR = 

14

388
Measurement 
Status

  int

ledState = 0 red, system error, gas  
conc. measurements invalid

ledState = 1 solid yellow, need  
service, gas conc. measurements 
might be ok

ledState = 2 blinking yellow, not in  
reporting mode by system ok, like 
during warmup

ledState = 3 green, system ok, gas  
conc. measurements accurate

9.5   Discrete Input Register Map
The following table describes the discrete input registers. Please note the following:
 l All data unit are unitless unless otherwise noted. 
 l All data types are floats unless otherwise noted.
 l All unused addresses are reserved. 
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Table 8 - Discrete Input Registers

Address Description

6 Pressure locked

7 Cavity temperature locked

8 Warm box temperature locked

73 Reserved

74 Reserved

75 Reserved

76 Reserved

77 Reserved

78 Reserved

79 Reserved

80 Reserved

81 Reserved

82 Reserved

83 Reserved

84 Reserved

85 Reserved

86 Reserved

87 Reserved

88 Reserved

89 Reserved

90 Reserved

91 Reserved

92 Reserved

93 Reserved
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Address Description

94 Reserved

95 Reserved

96 Reserved

9.6   Holding Register Map 
The following table describes the holding registers. 

Table 9 - Holding Registers

Address Description Units Type Comments

1-4 System time   int
Integer representing milliseconds  from 
1AD January 1st to now

5-8 User Name   String  

9-12 Password   String  

201-202 User data 1   Float  

203-204 User data 2   Float  

205-206 User data 3   Float  

207-208 User data 4   Float  

209-210 User data 5   Float  

211-212 User data 6   Float  

213-214 User data 7   Float  

215-216 User data 8   Float  

217-218 User data 9   Float  

219-220 User data 10   Float  

221-222 User data 11   Float  

223-224 User data 12   Float  

225-226 User data 13   Float  
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Address Description Units Type Comments

227-228 User data 14   Float  

229-230 User data 15   Float  

231-232 User data 16   Float  

233-234 User data 17   Float  

235-236 User data 18   Float  

237-238 User data 19   Float  

239-240 User data 20   Float  

9.7   Coil Register Map
The following table describes the coil registers.

Table 10 - Coil Register Map

Address Description Units Comments

116 Quit host application    

117 Shutdown Instrument   It will take approximately 2 min to  shutdown

151 Get system time  
After this please read Sync Time  holding 
register

152
User login (Coming in 
near future)

 
Before executing this command, user  needs 
to set user name and user password holding 
register

155
Update user 
password (Coming in 
near  future)

 

Before executing this command follow  the 
steps below:

 1. Login as  admin using User Login 
functionality if not logged in already.

 2. Set user name and password holding 
register.

156
User logout (Coming 
in near future)

   

201 Get User data 1    
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Address Description Units Comments

202 Set User data 1    

203 Get User data 2    

204 Set User data 2    

205 Get User data 3    

206 Set User data 3    

207 Get User data 4    

208 Set User data 4    

209 Get User data 5    

210 Set User data 5    

211 Get User data 6    

212 Set User data 6    

213 Get User data 7    

214 Set User data 7    

215 Get User data 8    

216 Set User data 8    

217 Get User data 9    

218 Set User data 9    

219 Get User data 10    

220 Set User data 10    

221 Get User data 11    

222 Set User data 11    

223 Get User data 12    

224 Set User data 12    

225 Get User data 13    
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Address Description Units Comments

226 Set User data 13    

227 Get User data 14    

228 Set User data 14    

229 Get User data 15    

230 Set User data 15    

231 Get User data 16    

232 Set User data 16    

233 Get User data 17    

234 Set User data 17    

235 Get User data 18    

236 Set User data 18    

237 Get User data 19    

238 Set User data 19    

239 Get User data 20    

240 Set User data 20    

 l Data is in big-endian format if it utilizes more than one Modbus register.
 l If input register functionality is not available for analyzer type, analyzer will return 

value as NaN for float values.
 l Registers in Red are coming in nearthe near future.
 l Memory map is continuous memory, so if user trytries to read address for which 

functionality is not available it will return 0 (for example reading address 0 for coil 
register).

 l If user tries to read address outside of maximum register memory map, request will 
be exception (for example reading address 156 for coil register).

NOTE
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9.8   Gas ID Map
The Gas ID input registers return a two-digit code to identify the gas species being 
measured.

Table 11 - Gas ID Map

Address Species Description

00 H2O Water

01 NH3 Ammonia

02 H2S Hydrogen sulfide

03 CO2 Carbon dioxide

04 CH4 Methane

05 CO Carbon monoxide

06 C2H2 Acetylene

07 C2H4 Ethylene

08 N2O Nitrous oxide

09 CH2O Formaldehyde

10 HF Hydrogen fluoride

11 O2 Oxygen

12 HCl Hydrogen chloride

13 C2H6 Ethane

14 H2O2 Hydrogen peroxide
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10 Troubleshooting
The following section lists problems that may be encountered during installation and 
operation of the analyzer. The corresponding step-by-step procedures provide resolution in 
most cases. If, after attempting these procedures, the problem remains unresolved, please 
contact Picarro Customer Support at +1 408 962 3991 (US) or +31 85 888 1650 
(International) or support@picarro.com.

10.1   Power LED on Analyzer Does Not Illuminate
Context: Turning on the analyzer by momentarily depressing its front panel power switch 
should apply power. The green power LED is illuminated when it detects the correct power 
levels.

1. Check that the AC power cord is attached and plugged into a working outlet.

2. Check that the rear on-off switch near the AC power cord is in the ON position ( I ).

3. Press and hold the front panel power switch for at least 5 seconds as the analyzer may 
take several seconds to respond.

10.2   Sample Pressure not Controlled to Appropriate Value for 
Concentration Measurements
Context: Under normal operation, the cavity pressure is automatically locked to the correct 
value by means of electronically controlled inlet and outlet valves. The message “Pressure 
Locked” on the front panel display and the user interface indicates that the cavity pressure is 
at the appropriate value. Should either of the messages “Pressure high” or “Pressure low” be 
displayed, the cavity pressure is out of its correct operating range. 

 1. Pressure low — Indicates that there is insufficient gas available at the inlet of the analyzer. 
Check the inlet plumbing to the analyzer and ensure that the pressure at the inlet is within 
the specifications. Check for blockages in the lines, or regulators that are turned off, 
especially by removing all items upstream of the inlet to see if the pressure returns to the 
spec. If removing plumbing from upstream of the instrument inlet doesn’t work, the inlet 
particulate filter may need to be replaced. See Chapter 12, Maintenance for more 
information.

 2. Pressure high — Indicates that gas cannot be removed from the analyzer at a sufficient 
rate. Check the vacuum line between the analyzer and the power vacuum unit for leaks. 
Failure of the vacuum pump, injecting dilution gas at excessive pressure, or excessive 
pressure at the inlet can also cause this problem

mailto:support@picarro.com
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11 Instrument Validation

11.1   Validation Overview
When required, the validation procedure can test that the instrument is operating as 
expected.

Validation is performed using low-concentration methane in place of hydrogen peroxide. 
Methane has the following advantageous characteristics:
 l Available as a certified, NIST-traceable standard
 l Non-hazardous at relevant concentrations.
 l Stable indefinitely.
 l Gaseous across the operational range of the instrument.
 l Has an absorption feature immediately adjacent to H2O2.

The validation procedure is based on sequentially introducing zero air and three methane 
standards. The H2O2 signal in zero air is measured to evaluate the zero offset for the H2O2 
spectroscopic model.

Separately, the methane concentrations in zero air and in each standard cylinder are 
measured, and a linear regression is calculated to demonstrate the linearity and zero-
accuracy of the analyzer. As any system performance problems that would affect the 
accuracy of the H2O2 slope (span) will likewise affect the slope for methane, this procedure 
provides a means of rapidly validating system performance using certified standards.

It will take approximately 60 minutes for data acquisition and analysis.

11.2   Required Supplies
Instrument validation requires the following:
 l Four cylinders of input gases:
 l One cylinder of zero air (dry synthetic hydrocarbon-free air).
 l Three methane standard cylinders. Three cylinders of methane, each with a different 

concentration, certified within +/- 2% composition uncertainty.  We recommend 
concentrations of 7, 50, and 100 ppm.

 l Four regulators (one for each cylinder being used). Each regulator should be capable of 
accurately delivering 2–3 psi (0.1–0.2 bar) of line pressure.

 l Sufficient tubing to connect the regulator(s) to the instrument. We recommend using ¼" 
OD PTFE or PFA tubing when working with hydrogen peroxide. While not required for 
work with methane, Picarro recommends using the same material in this procedure to 
avoid inadvertent use of inappropriate tubing in later work with hydrogen peroxide.

 l Suitable adjustable or fixed wrenches for making gas-line connections.

Please contact Picarro for further information about the supplies and accessories required 
for instrument validation.
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11.3   Safety
Of the concentrations used here, methane poses zero health, reactivity, or flammability risks. 
Follow all safety conventions appropriate for work with compressed gases, including use of 
eye protection, physical restraint of cylinders, etc.

11.4   Validation Procedure
1. Allow the system to reach operating temperature and pressure settings. (See 5.1   

Startup).

2. Attach regulators to the gas sources and adjust their output line pressures so they are 
within the range of 2–3 psi (0.1–0.2 bar).

3. From the Users menu, select User Login and sign in (requires technician or administrator 
privileges).

4. From the Tools menu, select H2O2 Validation. Login to the System Validation tool as an 
administrator (default user name is admin; default password is admin).

Figure 49 - System Validation Login

The Introduction to System Validation window displays. (Figure 50 - Beginning System 
Validation).

5. Click Next. The first-time validation is run, this will display the Edit Cylinders page (Figure 
51 - Edit Cylinders). Use this page to specify the concentrations and uncertainties of the 
cylinders being used in this procedure. See Table 12 -  Cylinder Button Functions for 
action definitions. On subsequent uses, the system will remember the saved values and 
skip directly to the Zero-Air Measurement step.

6. If this is the first-time performing system validation, enter the information for each of the 
cylinders you are going to use. Note that the uncertainty value is typically provided by the 
supplier for each cylinder.
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If validation has been run before, use this window to verify that the concentrations match 
the cylinders to be used and make any necessary updates.

Figure 50 - Beginning System Validation

Figure 51 - Edit Cylinders



11 Instrument Validation

97 PN 40-0047, REV F PI2114 User Manual

Table 12 - Cylinder Button Functions

Button Function

Add Add a new cylinder to the list.

Delete Remove the highlighted cylinder from  the list. (Click a cylinder to highlight it.)

Update
Click a cylinder, make changes to  the values shown at the bottom of the table, 
and click Update to save the  updated values.

Exit Exit the cylinder setup and return  to validation.

1. Once the cylinders are set up, click Exit to continue to Figure 52 - Zero Air Measurement 
Preparation.

Figure 52 - Zero Air Measurement Preparation

2. If this is not the first-time running validation on this system, click Edit Cylinder and verify the 
settings for the cylinders being used in this procedure (see steps 5–7).

3. Select the zero-air cylinder from the Select Cylinder list.

4. Open the valve on the zero-air cylinder.

5. Connect the zero-air cylinder to INLET on the back of the analyzer. (See 4.4   A2000 Pump and 
Gas Inlet Connections).

6. Click Next to begin measurement. This will take several minutes. Once it has finished with 
measuring the cylinder, it will show a confirmation dialog that measurement is complete 
(Figure 53 - Zero-Air Measurement).
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Figure 53 - Zero-Air Measurement

When the measurement is complete, the system will prompt you:

Figure 54 - Measurement Done Dialog

7. Click OK to proceed to the next step, Figure 55 - Calibrant 1 Preparation.

8. Disconnect the zero-air cylinder from the analyzer INLET.

9. Close the valve on the zero-air cylinder.

10. Open the valve on the first methane cylinder (the regulator should already be set to 2–3 psi).

11. Connect the cylinder to the analyzer INLET.

12. Select the cylinder from the Select Cylinder list.
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Select the cylinder Click Next.

Figure 55 - Calibrant 1 Preparation

13. Click Next to begin measuring the first cylinder (Figure 56 - Calibrant 1 Measurement in 
Progressshows data collection underway).

1 2
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Figure 56 - Calibrant 1 Measurement in Progress

14. Follow the prompts to finish measuring the first methane cylinder and to prepare and 
measure the next two methane cylinders. After the last cylinder has been measured, the 
system will prompt you to sign in again as a digital signature (11  Instrument Validation).

When switching cylinders, follow these steps to avoid damaging the instrument:
 l Do not turn off the gas valve before disconnecting the cylinder from the analyzer.
 l Before connecting the next cylinder, make sure its regulator is set to 2–3 psi (0.1–0.2 

bar) and open the regulator valve before connecting it to the analyzer INLET.
 l Refer to 4.4   A2000 Pump and Gas Inlet Connections for information on connecting to 

the INLET.

CAUTION
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Digital signature is required after all cylinders have been measured.

Figure 57 - Digital Signature Window

15. Enter your user name and password (must have technician or administrator privileges) and 
click Login to display the validation results.

Figure 58 - Validation Results

16. Click OK to clear the dialog and view a preview of the Validation Report as shown below.
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Figure 59 - Validation Report

17. To copy the Validation Report to a USB flash-memory drive, click Download Report.

Downloading the report will prompt you to sign in to the File Manager, which you can use to 
copy the report to a USB drive. See 8  File Management.

18. To return to the Data Viewer, click Exit Program.

19. Disconnect the last methane cylinder, making sure to disconnect it before closing the 
cylinder’s valve.

11.5   Example of Results from Validation
In the examples shown below, we collected data using four cylinders with nominal methane 
concentrations of 0, 7, 50, and 100 ppm.

Approximately five minutes of data were acquired for each concentration. Scaling for the 
relative sensitivity difference between methane and H2O2 (methane produces spectra 70-
fold weaker) these standards are comparable to 0, 100, 715, and 1430 ppb of H2O2 in terms 
of their utility in evaluating the fundamental performance characteristics of the instrument.
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Figure 60 - Validation Report – Page 1
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Figure 61 - Validation Report – Page 2

11.6   If the Analyzer Does Not Pass
If the analyzer fails the validation test, check the nominal CH4 on page one of the report 
against the actual CH4 concentration and uncertainty for the reference cylinders.

If there is a discrepancy, run the test again, correcting the discrepancies on the Edit Cylinder 
step.

If the analyzer did not pass and there is no discrepancy between the nominal values of the 
calibrants in the report and the values of the cylinders used during validation, contact 
Picarro. See back page for contact information.
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12 Maintenance
The advanced, rugged design of Picarro analyzers provides stable, long-term operation with 
minimal service or maintenance. With the exception of the following items, the analyzer and 
pump are not user serviceable. Should either appear to malfunction, please refer to the 
Troubleshooting Guide or contact Picarro Customer Support.

As described below, users may obtain preventive maintenance components as part of a 
service plan, as part of a designated PM kit, or individually from the Picarro store.

12.1   Service Plans
In addition to basic telephone and email support and remote diagnostics, service plans 
include an annual preventive maintenance kit and can be purchased by contacting 
sales@picarro.com. The three service plans are as follows:
 l W3101 Essential Service Plan — Free yearly maintenance kit; 50% discount on Field 

Replaceable Parts; 10-20% Discounted factory repair. See data sheet for complete terms 
and conditions.

 l W3102 Premium Service Plan — Free yearly maintenance kit; Extended warranty; Free 
factory repair; Free Field Replaceable Parts. See data sheet for complete terms and 
conditions.

 l W3103 Commercial Service Plan — Free yearly maintenance kit; Extended warranty; 
Free factory repair; Free Field Replaceable Parts; Loaner instrument; Free yearly 
prevention maintenance visit; Complimentary remote refresher training. See data sheet 
for complete terms and conditions.

12.2   Preventive Maintenance Kits
Preventive maintenance kits can be purchased by contacting support@picarro.com. The 
maintenance kits all include the following elements:

Replacement CPU Fan; particulate filter (Stainless Steel or Teflon); dust filter; replacement 
screws for instrument cover panels; Ball-Point Hex L-Keys; Anti-Static Wrist Strap.

The kits come in three forms depending on the instrument being serviced.
 l S3092 — Yearly Maintenance Kit for GHG, L2xxx, and EtO
 l S3093 — Yearly Maintenance Kit for PI2114
 l S3094 — Yearly Maintenance Kit for HAPs G2xxx User-Replaceable Hardware

12.3   User-replaceable Hardware – Individual Components
This section provides a list of components that are self-serviceable. These items can be 
purchased online through the Picarro store by using the links below.
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12.3.1 Particulate Filter
The inlet particulate filter is user-replaceable. Use the following link to order replacements 
and to find the instructional video and supporting maintenance document.

Parts

 l Stainless Steel Filter (for all models except those that measure HF, NH3, CH2O, HCl and 
H2O2):
S1020 Particulate Filter Kit – If viewing this manual as a paper hard copy, enter the 
following URL in your browser:
https://store.picarro.com/Particulate-filter-kit-all-models-except-HF-NH3

 l Teflon Filter: For models that measure NH3, HF, CH2O, HCl and H2O2
S1021 Particulate Filter Kit – If viewing this manual as a paper hard copy, enter the 
following URL in your browser:
https://store.picarro.com/Particulate-filter-teflon-for-NH3-HF._3

Instructions

 l Video: Replacing Your Inlet Particulate Filter 
https://www.picarro.com/environmental/videos/replacing_your_inlet_particulate_filter

 l Manual: Inlet Particulate Filter Maintenance Guide 
https://www.picarro.com/environmental/inlet_particulate_filter_maintenance_guide

12.3.2 CPU Fan
The analyzer CPU fan is user-replaceable. Use the following link to order replacements and 
to find the instructional video and supporting maintenance document.

Parts

 l CPU Fan for MI990 Motherboards:
S3267: PI5000 CPU Fan Replacement Kit. Includes the S3263 (CPU Fan) and required 
tools for replacement.nstructions

Instructions

 l Video: CPU Fan Replacement 
https://www.picarro.com/environmental/videos/cpu_fan_replacement

 l Manual: CPU Fan Replacement for Picarro Analyzers 

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-except-HF-NH3.html
https://store.picarro.com/Particulate-filter-teflon-for-NH3-HF._3
https://www.picarro.com/environmental/videos/replacing_your_inlet_particulate_filter
https://www.picarro.com/environmental/inlet_particulate_filter_maintenance_guide
https://www.picarro.com/environmental/videos/cpu_fan_replacement
https://www.picarro.com/environmental/cpu_fan_maintenance_guide
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12.3.3 A2000 Pump Rebuild Kit
The pump rebuild kit is the only component not currently sold as part of a preventive 
maintenance kit because the replacement frequency is not strictly annual (frequency 
depends on pump usage).

The A2000 pump diaphragms and valves are user-replaceable. Use the following link to 
order rebuild kits and to find the instructional video and supporting maintenance document.

Parts

 l Pump Rebuild Kit — Used with SI2xxx, G2xxx analyzers (except Flight and Flux 
analyzers)
S2009 Rebuild Kit for A2000 Vacuum Pump – If viewing this manual as a paper hard 
copy, enter the following URL in your browser:
https://store.picarro.com/Rebuild-kit-for-Picarro-A2000-vacuum-pump

Instructions

 l Manual: A2000 Pump Maintenance Guide 
https://www.picarro.com/environmental/a2000_pump_maintenance_guide

12.3.4 A0702 Pump Rebuild
The A0702 recirculation pump (if used with your analyzer) is not user serviceable. Instead, 
these pumps may be exchanged once they reach the end of their diaphragms’ operational 
life. Please contact support@picarro.com to coordinate this exchange.

12.4   Cleaning
Clean the outside of the analyzer with a clean dry cloth. Only certified service technicians 
should access or clean the inside of the analyzer.

https://store.picarro.com/Rebuild-kit-for-Picarro-A2000-vacuum-pump
https://www.picarro.com/environmental/a2000_pump_maintenance_guide
mailto:support@picarro.com
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13 Transportation and Storage
If the analyzer is transported or stored, use the following procedure to prepare and repack it 
into the original packaging.

When shipping or relocating the analyzer, it is important to protect it from mechanical 
shocks. Failure to do so can compromise its performance. When shipping the analyzer, 
use its original packaging only.

13.1   Shutdown and Preparation

A flow of clean, relatively dry gas should always be directed to the instrument for several 
minutes prior to shutting down. Trapping a high-moisture content gas sample in the 
cavity can cause condensation damage to the mirrors as the instrument cools from its 
operating temperature. See 5.2 Shutdown , for specific shutdown instructions for your 
model analyzer.

20. Click on the Quit button located on the left side of the Data Viewer window.

21. A window displays prompting the user to confirm the shutdown. Click Yes to continue 
the shutdown process.

Figure 62 - Stop Data Acquisition/Shutdown

22. Confirm the level of water vapor prior to shutdown. Click No, if the analyzer was dried 
before shutdown. Click Yes, if the analyzer requires dry gas to reduce the moisture 
content.

CAUTION

CAUTION
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Figure 63 - Reduce Moisture Content/Shutdown

Once confirmed, the analyzer software and hardware will turn off.

23. Manually turn off the pumps and dry gas (if used).

24. Disconnect all tubing and electrical connections from the analyzer.

25. To prevent contamination and possible damage to the connector threads, place 
protective caps on all gas connections.

13.2   Packing
1. Place the analyzer in a plastic bag with a package of desiccant.  Seal the bags with tape. 

If shipping the pump, do the same for it.

2. Pack the analyzer and pump in the original shipping containers ensuring that all the foam 
pieces are in place to protect the analyzer during shipping.
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A Measurement Status Messages
Table 13 - Measurement Status Messages

Message Description

Aborting[DR1] …  

Disabling Data Manager Exiting measuring state.

Leaving Measuring  

Measuring
This is the normal mode of  operation. The analyzer will scan 
and report concentration measurements until  it is shutdown.

Parking
Entering parking state, system is  venting cavity prior to shut 
down.

Parking Sample
Entering parking state, system is  venting cavity prior to shut 
down.

Preparing Sample Manager  

Preparing to Measure
Spectral scanning has started.  Concentration 
measurements will be available in approximately 30 
seconds. 

Pressure = %d Torr Dynamic reporting of pressure as  instrument is shut down.

Pressure stabilizing
The valve control system is allowing  flow through the 
analyzer and is stabilizing the pressure inside the cavity.

Pressure Locked
The valve control system has  stabilized the pressure inside 
the cavity.

Pressure Unlocked  

Purge Complete  

Putting Data Manager in 
warming mode   

Exiting measuring state.

Reset  

Restart Measuring
This is the normal mode of  operation. The analyzer will scan 
and report concentration measurements until  it is shutdown.

Sample prepare complete  
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Message Description

Shutdown  

Starting  

Temp and Pressure 
Stabilizing

Entering warming state.

Temperature Locked: HB

The temperature of the “hot box” (HB  – the chamber 
containing the analyzer’s optical cavity and gas handling  
system) is stable. 

Achieving stability is typically the  longest step in the startup 
sequence. It may take from 5 to 60 minutes to  lock, 
depending on the ambient temperature and how much time 
has elapsed  since the unit was shut down.

Temperature Locked: WB
The temperature of the “warm box”  (WB – the chamber 
containing the electronics and wavelength monitor) is  stable.

Temperature Unlocked: HB  

Temperature Unlocked: 
WB

 

Uploading warmbox cal to 
DAS…

Entering warming state.

Warming…  
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B Setup Tools and Communication

B.1   Analyzer Settings and Tools
The Analyzer Setup Tools is accessed by using the Picarro Launch Pad and Settings button. 
These set of tools allow the user to configure data file saving details, including which data 
elements are written to data files, digital data output (via serial port or TCP/IP), and optionally 
configured electrical interface for additional measurement monitoring.

You must be logged in as a technician or administrator to access the Analyzer Setup 
Tools under Settings.

The settings of the Setup Tool are explained in the next pages in brief. A more in-depth 
description of the material is provided in the subsequent sections. If you have any questions 
about the Setup Tool, please contact Picarro or refer to Picarro Community for further 
details: https://www.picarro.com/support/community.

Figure 64 - Analyzer Setup Tools

NOTE

https://www.picarro.com/support/community
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Before running any of the setup tools, the instrument software must be stopped. From 
the CRDS Data Viewer, select the Quit button and click Yes when prompted to stop data 
acquisition. The Setup Tool options are now active.

B.1.1 Serial Port
The Serial Port menu is accessible from the  Menu and displays the configurations of COM1 
(used for Command Interface, query-based data output) and COM2 (used for Data 
Streaming). Users need to set the COM port protocol by using the Serial Port Configuration 
feature located from the Picarro Launch Pad, Config, and selecting the Serial Port button.

Figure 65 - Serial Port Settings

Configure the ASCII serial port by setting the Data Out and Command Interface parameters 
that are used for RS-232 serial communication.

The following options are provided:
 l Port — Indicates the desired communication port.
 l Baudrate — Specifies the rate at which bits are transmitted.
 l Data Bits — Specifies the number of data bits to transmit.
 l Stop Bits — Specifies the number of bits used to indicate the end of a byte.
 l Parity — Indicates the type of parity checking.
 l Enable Serial Port — Enables or disables the communication port specified in the Port 

field.

NOTE
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After making changes, select Save to apply the changes or Undo to revert to the previous 
configuration. Click OK to close the window.

B.1.2 Port Manager
The Port Manager allows you to control digital data output/input by using the serial port or 
TCP/IP.

Figure 66 - Serial/Socket Port Manager Settings

The following options are available within the Port Manager menu. Note /dev/ttyS* is a 
naming convention for serial ports on Linux. /dev/ttyS0 indicates the first serial port (COM1), 
/dev/ttyS1 suggests the second (COM2), and so on.
 l Data Streaming — The port you want your data to stream through. 
 l Valve Sequencer MPV (Multi Position Valve) — The port you want to connect your MPV. 
 l Command Interface — The port you want to connect your command-line interface. 

Make sure there are no COM port conflicts before clicking Save.

After making changes, select Save to put these changes into effect and click OK to close the 
window.

B.1.3 Command Interface — Specifying Digital Data Output
The Command Interface allows you to specify the data elements that are sent by using COM 
port/TCP (specified in the Port Manager).
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Figure 67 - Command Interface Settings

Two types of data can be specified here:

Output Data Source:
 l Datalog_User
 l DataLog_User_Sync (relevant only for Flux G2311-f analyzers)

Output Data Columns:
 l The data columns are output in the order they are checked, e.g., H2O, could come before 

CO2. The Command Interface enables an external device to send a set of predetermined 
commands to a Picarro analyzer. The Picarro returns data or metadata on the basis of the 
command received.

After making the appropriate changes, click Save to put changes into effect and then OK to 
close the window.

B.1.4 Data Streaming— Specifying Digital Data Output
The Data Streaming menu allows you to specify the data elements that you want to send by 
using COM port (specified from the Port Manager).
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Figure 68 - Data Streaming Settings

Two types of data can be specified here:

Output Data Source:
 l Datalog_User
 l DataLog_User_Sync (relevant only for Flux G2311-f analyzers)

Output Data Columns:
 l The data columns are output in the order they are checked, e.g., H2O, comes before CO2. 

Command Interface enables an external device to send a set of predetermined 
commands to a Picarro analyzer. The Picarro returns data or meta-data on the basis of 
the command received.

Data Streaming outputs data continuously, whereas the Command Interface needs 
commands to output data.

After making the appropriate edits, click Save to put changes into effect and then OK to 
close the window.

NOTE
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B.1.5 Data Logger
The Data Logger allows the user to configure various data file saving details, including which 
data elements are written to data files.

Figure 69 - Data Logger Setup Settings

The following data file options can be specified:
 l Data Columns — Controls which data elements are written to data files.
 l Hours of Each Log File — Controls the size of each data document.



B Setup Tools and Communication

PI2114 User Manual PN 40-0047, REV F 118

 l Enable Mailbox Archiving — Enables archiving of data in the mailbox folder:
/home/picarro/I2000/Log/Archive/DataLog_Mailbox

 l Archived Directory Structure — Specifies part of naming convention for data documents.
 l Total User Log Storage Size (GB) — Specifies the size of storage allowed for User Data 

(Recent Data).
 l Mode — Changes the way the analyzer fits and displays data in the data viewer on the 

basis of gas matrix, species reported, precision, and dynamic range.

After making the appropriate edits, click Save to put changes into effect and then OK to 
close the window.

B.2   Serial Communication
The analyzer supports an RS-232 physical command interface, which can be used to control 
the instrument and to retrieve concentration data. Not all features of the instrument are 
available on the serial interface.

For details on using the serial command interface, please see the Picarro Analyzer Remote 
Interface Programming Guide.

This command set may also be used across a TCP/IP interface through an Ethernet 
connection. Please contact Picarro for further details if needed.

B.2.1 Remote Data Access
Using the RemoteAccess.ini file, the analyzer can be configured to automatically:
 l Send data from the instrument to a list of e-mail accounts.
 l Measure the offset of the host computer system clock from a set of Internet time servers 

and (optionally) to resynchronize the clock based on this information.

The Internet connection need not be permanent and may be a dial-up connection accessible 
by using a user-supplied USB modem. The task of sending data and/or synchronizing the 
clock on the analyzer is performed using the 
/home/picarro/I2000/HostExe/RemoteAccess.exe program.

Each time that the RemoteAccess.exe program runs, it appends information to a log file, 
which keeps a record of the results of the time synchronization and of the files sent by e-mail. 
The RemoteAccess.exe program is configurable by means of an initialization file, which 
includes information such as the login credentials for the dial-up connection, the e-mail 
account, and the list of time servers.

The initialization file is:

/home/picarro/I2000/AppConfig/Config/UtilitiesRemoteAccess/RemoteAccess.ini

NOTE

https://www.picarro.com/environmental/remote_interface_programming_guide_400063_reva
https://www.picarro.com/environmental/remote_interface_programming_guide_400063_reva
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It should be placed in the same directory as the executable RemoteAccess.exe. The file has 
one required section named LOGGING and optional sections named NTP and EMAIL. The 
logging section has a single key Logfile whose value is the path to the log file. Once this log 
file exceeds 64 Kbytes in length, it is backed up, appending a numeric extension to the file 
name, and a new file is opened. A total of ten backup log files are kept.

B.2.2 NTP
The NTP section controls querying the Internet time servers using the SNTP protocol 
(RFC4330) and the resetting of the clock on the host computer. If the section is not present, 
time synchronization is not carried out. The keys Server1, Server2, etc., are used to specify 
the URLs of the time servers. If the UpdateClock key is set to “true,” the offset is applied to 
the host clock. Otherwise, the offset is recorded, but the host clock is not changed.

B.2.3 Email
The EMAIL section controls the sending of the data files as e-mail attachments. If the section 
is not present, e-mail messages are not sent. The key Directory specifies the directory that 
contains the data files. When the program is run, files in this directory are sent to the 
specified recipients and the files are deleted. To avoid problems with incomplete files, 
programs that place files into this directory should do so using an atomic operation, such as 
a rename. The Server key is set to the name of an RFC2821- compliant SMTP server that 
sends the e-mail messages.

The From key is the e-mail address from which the messages are sent. Note that some 
SMTP servers check that the source is permitted to send email while others allow any name 
in this field. The collection of e-mail addresses to which copies of the e-mail is sent is 
specified by the keys To1, To2, etc. The Subject key is used to fill the subject field in the 
email header and may be set to any string. Depending on the SMTP server, it may be 
necessary to use authentication before e-mails can be sent, as described in RFC2554. If 
such authentication is not needed, the key UseAuthentication is set to false. If this key is set 
to true, two additional keys Username and Password must also be specified for the e-mail 
account. 
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C Analog Signal Output
This analyzer is configured with an optional Electrical Interface Card (EIC) that provides 4 
analog signals for monitoring various measurement results and analyzer parameters.

Two circular connectors, on the back panel of the analyzer (are available for analog output. 
The pinout for each connector is listed in the table below. 

The following figure shows the analog channel connectors on the back of the analyzer.

Figure 70 - Analog Channel Connectors

Two external cables (for the analog channel connectors) are provided with the analyzer. The 
mating connector is part number HR25-7TP-8P(72)

C.1   Analog Signal Pin Mapping
The following table lists the analog pinouts and provides the analog pinout map.

Table 14 - Analog Pinout Table

Pin Function

 

Pin Function

1 GND 0 1 GND 4

2 Channel 0 2 Channel 4

3 GND 1 3 GND 5

4 Channel 1 4 Channel 5

5 GND 2 5 GND 6

6 Channel 2 6 Channel 6

7 GND 3 7 GND 7

8 Channel 3 8 Channel 7
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Figure 71 - Analog Pin Map

C.2    Configuration
+1 volt indicates 0 in all cases: Each channel has a +1 volt offset. Treat <=0 volts as an error. 
This helps prevent reading the wrong values because of improper wiring (ground loops). 

Example for Channel 0: 1V = 20 ppb with a 1V offset. 9v x 200 ppb/V = 180 ppb = 1.8 ppm.

The following table provides the master analog configuration.

Table 15 - Analog Configuration Master

Channel Parameter

Output Scale

(<1V indicates 
error)

Conversion

All channels have a 
+1V offset

(+1V=0)

Indicating Range

1V to 10V or 0 to 
90 ppb

0
H2O2 

concentration
0-10V 10 ppb/V 0 to 90 ppb

1
H2O2 

concentration
0-10V 100 ppb/V 0 to 0.9 ppm

2
H2O2 

concentration
0-10V 2 ppm/V 0 to 18 ppm

3
H2O 

concentration
0-10V 2%/V 0 to 18 ppm

4 DAS Temp 0-10V 10o C/V 0 to 90oC

5 None NA NA NA

6 None NA NA NA

7 None NA NA NA
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D Analog Current Signal Output
Four channels of 4-20 mA current analog output are available on the back of the analyzer. 

Figure 72 - 4–20 mA Output with Terminal Connector

Table 16 - Signal Output Settings

  Iout0 Iout1 Iout2 Iout3

Monitoring H2O2 Cavity Temperature DAS Temperature Cavity Pressure

Units ppb Degrees C Degrees C Torr

Min 0.0 0.0 0.0 0.0

Max 1000.0 100.0 100.0 1000.0

 l H2O2 — Displays the H2O2concentration reading in parts per billion (ppb)
 l CavityPressure — Displays the cavity pressure in degrees Celsius
 l DasTemp — Displays the internal logic board temperature in degrees Celsius
 l CavityPressure — Displays the cavity pressure in Torr

D.1   Connecting the 4–20mA Signal Output
To connect to the output:

1. Using your fingers, pull the 4–20 mA terminal connector straight back away from the 
analyzer.

Figure 73 - Removing the Terminal Connector

2. Use a small slotted screwdriver to loosen the retaining screw for the desired terminal.
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Figure 74 - Terminal Connector Retaining Screws

3. Insert the stripped end of the wire into the terminal.

4. Tighten the retaining screw.

5. Repeat for each desired terminal.

6. Slide the terminal connector back onto the analyzer with the retaining screws facing 
down; there should be a soft click when the connector is set into its proper position.

If shielding is desired, connect the drain wire of the shielded cable to the ground lug 
on the back panel. Do not connect the shield to the ground pins of the 4–20 mA 
connector. Connect only one end of the shielded cable to the ground lug to avoid 
ground loops.

D.2   Power Requirements
The 4-20 mA analog current signal output requires an additional user supplied power 
supply for operation. See the following diagram for more information.

Figure 75 - 4-20 mA Power Requirements

NOTE
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E Data File Viewer

E.1   Quick Start Guide
The following sections introduce the user to all possible functionalities of the Data File Viewer 
in detail. This section describes the most common, simple use case.

The Data File Viewer software allows the user to concatenate multiple one-hour files into one 
larger file, enabling the user to observe trends over several days of measurements.

1. To start, translate the UserData files from DAT to H5. The Batch Convert option (B) 
allows user s to select any folder containing instrument data from a given day.

Figure 76 - Batch Convert DAT to H5 – Navigation

2. In the source folder there are now copies of the original files translated into the H5 format.

3. From File menu select Concatenate H5 Files (C) to combine the H5 files into a time 
series. Take care to select exactly the same folder in the file viewer window.

4. In the Select Variables window, click All to move over all variables for concatenation. If 
concatenating large records, the user can instead select only a few variables by clicking 
the variable name on the left dialogue, and clicking the double arrow button. Confirm by 
clicking OK.
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Figure 77 - Selecting Variables for Concatenation

5. The user will then be asked to confirm the file name for the concatenated data. The 
default location is the parent folder for the selected day, and the filename by default 
describes the time span of the measurements within. Successful concatenation is 
indicated by the filename automatically being displayed in the main data file viewer 
window as shown in the following figure.

Figure 78 - Concatenated Output .h5 Filename
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You can concatenate several days into one larger file, either by following steps 1-3 
for selected folders, or by copying all their DAT files into a new folder and performing 
steps 1-5 just once.

6. With the file now opened, the user can select how many Time Series to display on the 
screen.

Figure 79 - Time Series Selection Options

7. In the new window that displays, select the variables from the Var Name dropdown on 
the right of each plot. Deselect Autoscale y if the data stream has a large amount of 
variability in the Y-axis.

8. Please read the following sections to learn more about features of the Data File Viewer.

E.2   Data File Viewer Overview
The Picarro Data File Viewer software is located from the Picarro Launch Pad,  Home menu. 
This software allows you to graph and to conduct statistical analysis of the raw data. 
Additional functions include Allan Variance plot and quadratic or polynomial fittings. The 
Picarro Data File Viewer includes two main menus: File and New.

NOTE
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Figure 80 - Picarro Data File Viewer – File and New Menus

E.2.1 File Menu
This section describes the functions available from the Data File Viewer File menu.

Open File

File > Open File: Opens a Picarro data file (HDF5 format) for data analysis and visualization. 
After opening the data file, you can create a new time series plot. Refer to E.2.2 New — Time 
Series Plot for more information.

Load Config

File > Load Config: Loads a configuration file (ini format) to restore parameters of a 
workplace. Refer to E.3.1 Save Configuration for more information.

Unpack Zip File

File > Unpack Zip File: Use to concatenate all H5 files inside the zip file into a single H5 file. 
Refer to  Concatenate H5 Files below for details.
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Concatenate H5 Files

File > Concatenate H5 Files: Use to concatenate multiple files and zip archives of H5 files 
into a single H5 file. Navigate to the desired folder or use the Define Date Range button to 
specify a date range of files to concatenate. (see  Define Date Range).

After selecting the path of the data files, Data File Viewer will automatically search an H5 file 
in the specified zip/folder and look for all available variables in the H5 file. The variables are 
then listed in the Select Variables window in the left panel, and users can use the >> button 
to move variables to the right panel for concatenation.

Figure 81 - Select Variable Form

This screenshot is for example only. The species selections shown on your analyzer may 
vary.

Define Date Range

Data File Viewer can search data files within the desired date range and then concatenate 
such files into an H5 file.

NOTE
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By default, TimeZone is set to your local time zone. However, if data were taken elsewhere, 
select the time zone where data was taken.

Select File > Concatenate H5 Files, and click Define Date Range to specify the desired date 
range as shown in the following figure.

Figure 82 - Define Date Range Dialog

Picarro software saves data in directories that are named by the creation year, month, and 
day. Select Data files are saved in directory trees named by date and time option if the target 
folder has this file structure. This allows Data File Viewer to only search folders within the 
desired date range, which can substantially reduce processing time.
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Figure 83 - File Structure of Data File Viewer

To save processing time, Data File Viewer does not open data files, but only determines 
data acquisition time based on the file name.

Do not define a time range for data files whose names have been changed.

Data File Viewer does not concatenate data files exactly within the defined time range. 
This is because the time extracted from file name is different from the data acquisition 
time. To not miss data points, Data File Viewer expands the specified time range, so the 
resulting data set normally has a wider time range than the user specification.

NOTE

CAUTION

NOTE
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Convert DAT to H5

Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 format. These 
formats are described below:
 l DAT Format: DAT files accepted by DatViewer store tabular data (numbers and text) in 

plain text.
 o Each line of the file is a data record. Each record consists of one or more fields 

separated by whitespaces.
 o The first line of the data file indicates column names.
 o There must be a field “EPOCH_TIME” to store the acquisition epoch time (expressed 

as seconds since Jan 1, 1970) of the data. Otherwise, the first and second fields must 
be “DATE” and “TIME”. The “DATE” field must have the format “mm/dd/yyyy” or “yyyy-
mm-dd”, and the “TIME” field must have the format “HH:MM:SS(.sss)” where (.sss) is 
an optional fraction of seconds.

 l HDF5 Format: HDF5 is a data model, library, and file format for storing and managing 
data. (See the HDF5 Home Page on the HDF Group website https://www.hdfgroup.org/ 
for more information.) When converting DAT to HDF5 format, Data File Viewer creates a 
table named “results” to the contained data.

Convert H5 to DAT

Select File > Convert H5 to DAT to convert a file in a HDF5 format to DAT. These formats are 
described in Convert DAT to H5.

Data File Viewer does not concatenate data files exactly within the defined time range. 
This is because the time extracted from file name is different from the data acquisition 
time. To not miss data points, Data File Viewer expands the specified time range.

Interpolation

Interpolation describes the method for constructing data points with a range of a discrete set 
of known data points. Select File > Interpolation to perform interpolation on a time grid with a 
constant interval.

Block Average

Select File > Block Average to divide a data set into small blocks based on a user-defined 
block size. The average is calculated for data in each block, and the results are saved in a 
new H5 file.

NOTE

https://www.hdfgroup.org/
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The specified block size must be greater than the average data interval.

Because the data interval is normally not a constant (unless interpolation is performed), 
fluctuations in the data interval will affect block averaging if the block size is comparable to 
the average data interval.

E.2.2 New — Time Series Plot
You can specify to include create time-series plots with one, two, or three frames. New plots 
display in the Time Series Viewer.

This screenshot is for example only. The species shown on your analyzer may vary.

Figure 84 - Time Series Viewer

NOTE

NOTE
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The next section describes the options available on the Time Series Viewer menu bar. Refer 
to The Time Series Viewer Canvas or more information on the Time Series Viewer UI features 
and options.

E.3   Time Series Viewer Menus
The Time Series Viewer form includes the following menus:

Figure 85 - Time Series Viewer Menus

Use the File menu to save a configuration or take a screenshot.

Figure 86 - Time Series Viewer – File Menu

E.3.1 Save Configuration
Click File > Save Configuration to open the Feature Capture form. With this form, you can 
save figure properties, expressions, filters, and other settings to a configuration file so that it 
can be easily loaded in the future.

Figure 87 - Time Series Viewer – Feature Capture
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If a feature is not captured, it will be omitted when the configuration file is loaded.

Depending on the features captured, loading a configuration file can have different effects. 
For example:
 l If all features are captured, a saved workplace is reproduced.
 l If a data file is not captured, saved parameters are applied to the data file in memory.
 l If an expression is not captured, plots will not be transformed.
 l  If X (Y) range is not captured, figures are auto-scaled on the x (y) axis.

E.3.2 Take Screenshot
Use File > Take ScreenShot to take a screenshot of the Time Series Viewer and save it as a 
.png to a specified file.

E.3.3 Time Series Viewer Analysis Menu
Use the Analysis menu to calculate statistics, generate a histogram, and to plot correlations 
and Allan Standard deviations.

Figure 88 - Time Series Viewer – Analysis Menu

Statistics

Use Analysis > Statistics to calculate mean, standard deviation, and peak to peak for all 
plots in the current window.

Histogram

Use Analysis > Histogram to generate a histogram of data.

CAUTION
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Figure 89 -  Histogram Window 

Histogram Window Features

 l Red Line — A Gaussian function fitted to the histogram. Fitting results of μ and σ are 
shown in the top-left corner of the plot.

 l Bin — Specifies the number of intervals that the range of values is divided into.
 l Normalized — When selected, the sum of the histograms is normalized to 1.
 l Save data — Saves histogram data to a CSV file.
 l Save image — Saves the histogram image as a JPEG/PNG/PDF file.

Correlation Plot

Use Analysis > Correlation Plot to plot Y-axis data in one frame versus that in the other. This 
can be used when two or more frames exist in the current Time Series Plot window. See the  
Correlation/XY Plot for details.

Allan Standard Deviation Plot

Use Analysis > Allan Standard Deviation Plot to create an Allan Standard Deviation plot 
(versus a standard deviation plot) for data in the current window. See Allan Variance 
Wikipedia page for more information.

E.3.4 Time Series Viewer View Menu
Use the View menu to view X-axis information in date-time, minute, or hour format.

https://en.wikipedia.org/wiki/Allan_variance
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Figure 90 - Time Series Viewer – View Menu

When switching from Datetime to Minute or Hour, the X-axis data is subtracted from the 
earliest point shown in the panel and then converted to the desired unit.

E.3.5 The Time Series Viewer Canvas
The Time Series Viewer canvas is comprised of interactive graphs and a variety of 
configuration options.

This screenshot is for example only. The species shown on your analyzer may vary.

NOTE

NOTE
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Figure 91 - Time Series Viewer Canvas

Mouse Options and Graph Transform

The following mouse actions can be used in the canvas graphs:
 l Left-click and drag — Zooms into the selected area of the plot.
 l Left-click and drag with the SHIFT key down — Pans the plot.
 l Left-click and drag with CTRL key down — Zooms out from the plot.
 l Left-click and drag with ALT key down — Stretches the plot.
 l Right-click — Opens an additional menu. Refer to the Right-click menu below in the next 

section.

Right-click Menu

Right-clicking on the canvas opens a pop-up menu:
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Figure 92 - Canvas Right-click Pop-up Menu

The following options are available from the right-click menu.
 l Export Image — Exports the current plot as a jpeg, png, or pdf file.
 l Export Data in Current View — Exports only date/time and the selected variable in the 

current view to an HDF5 or CSV file.
 l Export All Data in Current Time Range — Exports all variable columns of the selected 

dataset in the current time range to an HDF5 file. Refer to Concatenate H5 Files on Page 
81 for more information.

 l Edit Plot Properties — Opens the Image Editor form where the following options can be 
specified.

Image Editor

Figure 93 - Time Series Viewer Image Editor

Image Editor Form Options:
 l Title — Edits the title of the plot.
 l Line — Specifies the line pattern of the plot. If None is selected, the data points will be 

plotted without connecting lines.
 l Marker — Specifies the marker type to indicate data points. If None is selected, data 

points will not be shown.
 l x-Axis — Min and Max: Specifies the minimum and maximum date range for the X-axis.
 l x[0] — Sets the earliest time of the dataset as the minimum of the X-axis.
 l Time zone — Sets the time zone for date/time variables. This defaults to the local time 

zone.
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 l Label — Specify labels for the X-axis and the Y-axis.
 l y-Axis — Min and Max: Specifies the minimum and maximum of data displayed on the Y-

axis.

Dataset Name and Var Name

An HDF5 file can store one or more tables. Each of these tables is called a Dataset. A table 
can contain one or more columns. Each column is called a variable (Var).

Use the Dataset name drop down to select the dataset that is used for this time series graph. 
Use the Var name drop down to select the column in the dataset to use in the graph.

Figure 94 - Time Series Viewer Dataset Options

Autoscale Y

When the Autoscale Y option is selected, the Time Series Viewer will autoscale on the Y-axis 
to make sure that all data within the range of the X axis is displayed. This feature can make it 
hard to see small signals when large signals blow the Y axis out, so it is often advisable to 
deselect this check box for dynamic or spikey datasets.

Average

If Block is selected, a block average is calculated when you click the Do average button. 
Otherwise, a moving average is calculated.

For a block average, Size specifies block size in unit of a minute. For a moving average, Size 
specifies subset size in unit of data points.

Averaging is performed after the Filter and Expression are performed.

REMINDER
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Mean, Std Dev, and Peak to Peak

The Mean, Std dev (Standard deviation) and Peak to peak fields (Figure 94) provide all the 
statistical information of data in the current view.

Correlation/XY Plot

The Correlation/XY Plot window includes three menu items: File, Fitting and Analysis. For 
details about the File menu, see E.3.1 Save Configuration and E.3.2 Take Screenshot. Fitting 
and Analyst are described below.

The canvas in this plot is interactive. For details about the plot canvas, see E.3.5 The 
Time Series Viewer Canvas.

Figure 95 - Correlation XY Plot

E.3.6 Fitting Menu
The Fitting menu includes three options which are described below.

REMINDER
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Figure 96 - Fitting Menu

Fitting allows you to specify one of four fitting methods to include in the Correlation/XY plot:
 l Linear Fit — Specifies to fit to linear function:

y = c1x + c0
 l Quadratic Fit — Specifies to fit to quadratic function:

y = c2x2 + c1x + c0
 l Polynomial Fit — Specifies to fit polynomial function of degree n:

y = Σcnxn
 l Curve Fit — Specifies to use non-linear least squares to fit an arbitrary function to data.

E.3.7 Analysis Menu
The Analysis menu has two options: Integration and Statistics.

Figure 97 - Analysis Menu

 l Integration — Calculates area under the curve using the composite trapezoidal rule.
 l Statistics — Calculates mean, standard deviation, and peak to peak for data in the current 

view.

After applying any of the above Analysis options, the results, statistics, or fitting function with 
coefficients are displayed in the lower portion of the Correlation Plot window.

Figure 98 - Results of Quadratic Fitting
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F Setting up Contained Exhaust Flow
The A2000 vacuum pump is shipped with a noise dampener attached to the exhaust port. 
When a hazardous gas exhaust line from the pump is needed, it requires replacing the noise 
dampener with an adapter that allows a 1/4” OD exhaust tubing connection. Use the 
following instructions when installing a pump exhaust line.

Exhaust Port with Noise Dampener Vacuum Port

Figure 99 - A2000 Pump Vacuum and Exhaust Ports

F.1   Tools and Parts Required
 l Long flathead screwdriver (6” x 5/16” recommended) 
 l 9/16” open end wrench 
 l Swagelok ISO parallel thread adaptor 1/4"-1/8” SS-400-1-2RS (Picarro PN 22928)
 l Swagelok gasket SS-2-RS-2V (Picarro PN 22929)
 l 1/4" tubing and stainless-steel ferrule set
 l Snoop leak-detection fluid or similar soap solution

F.2   Directions
1. Remove the noise dampener fitting from the bottom of the pump using a long flathead 

screwdriver (Figure 100). 

1 2
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Noise Dampener 

Figure 100 - Pump Noise Dampener Removal

2. Slide the adapter gasket PN 22929 onto the adapter fitting PN 22928 (Figure 101), screw 
it into the pump exhaust port, and then tighten it 1/4 turn using a 9/16” wrench. 

3. Remove the Swagelok nut and ferules from the adapter fitting to ensure their orientation 
is as shown below, then loosely reattach to the adapter.

4. Slide the 1/4” exhaust tubing into the Swagelok nut and ferules until the tubing is fully 
seated, then using a 9/16" wrench, tighten the nut approximately seven flats (420 
degrees).

Adapter Fitting PN 22928

Adapter Gasket PN 22929

Figure 101 - Pump Exhaust Line Adapter Fittings

5. With the pump running on room air, apply Snoop leak detection fluid to the installed 
exhaust components to confirm that the system is leak tight. Instructions for leak testing 
using Snoop can be found in this video: https://vimeo.com/375518688 (go to time 5:20 
in the video)

1

1

2

https://vimeo.com/375518688
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G External Valve Sequencer 

G.1   Introduction
The Picarro analyzer can control two types of valves:
 l Rotary Selector Valve — Digitally controlled valve used to send selected flow from one of 

many inputs (up to 16) into the analyzer.
 l Solenoid Valves — DC voltage powered valve with normally open (NO) and normally 

closed (NC) positions. These can be 2-way or 3-way valves.

Both types of valves can be simultaneously controlled through a common software interface 
called the External Valve Sequencer (described in G.6 External Valve Sequencer Software 
Overview) which is available from the Tools menu on the GUI.

Picarro offers two rotary valve and two solenoid valve solutions:
 l A0311 — 16-Port Distribution Manifold.
 l A0311-S — 16-Port Distribution Manifold (Silco) which is optimized for use with sticky 

and reactive gases.
 l S3112 — 3-Way stainless steel solenoid valve with 1/4” fittings.
 l S3136 — 3-Way stainless steel solenoid valve with 1/8” fittings.

G.2   A0311 16-Port Distribution Manifold

G.2.1 Compatibility 
The A0311 (Figure 102) is broadly compatible with most Picarro analyzers except for those 
with known surface and chemical compatibility issues (such as the G2103, SI2103, SI2108, 
SI2104, SI2205, G2307, G2509, and PI2114).

G.2.2 Function
The A0311 and External Valve Sequencer GUI makes it easy to program the sequence and 
duration of sample intake from various attached sampling lines, flasks, or bags. The manifold 
is controlled using either the Picarro analyzer GUI or an external hand-pad (included with the 
A0311).

The A0311 samples up to 16 gas sources. During operation, the selected line is routed 
through the valve into the analyzer. The 15 lines that are not selected terminate in the valve.

For detailed instructions on integrating the A0311 with your analyzer, refer to the 16-Port 
Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-0038).

 

NOTE
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Figure 102 - A0311 – 16-port Distribution Manifold

G.3   A0311-S 16-Port Distribution Manifold (Silco)

G.3.1 Compatibility
The A0311-S (Figure 103) is broadly compatible with all Picarro analyzers but is optimized for 
use with sticky and reactive gases in the following platforms, nominally:
 l G2103, SI2103, SI2108, SI2104, SI2205, G2307, G2509, and PI2114

G.3.2 Function
For users who require faster response performance, the A0311-S is a 16-Port distribution 
manifold with a flow through valve for reduced memory effects. Designed to optimize 
response time in the presence of reactive gases, the A0311-S uses SilcoNert® coated 
components, PFA tubing, and an additional vacuum pump.

The sampling duration and sequence is easily programmed through the Picarro External 
Valve Sequencer GUI. This design is ideal for fast switching between different locations for 
specialty applications in semiconductor, pharmaceutical, environmental research, and other 
industries. 

For detailed instructions on integrating the A0311-S with your analyzer, refer to the 16-
Port Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-0038).

Figure 103 - A0311-S – 16-Port Sequencer – Fast Multiport Gas Sampler

NOTE



G External Valve Sequencer

PI2114 User Manual PN 40-0047, REV F 146

G.4   Setting Up Solenoid Valves
The Valve Sequencer software can control up to six solenoid valves. Each valve should 
operate using 12 VDC with a maximum quiescent current of 500 mA. Most analyzers come 
with a valves cable that can be connected to the solenoid valves, and if not, one can be 
purchased by contacting support@picarro.com.

Be careful to avoid shorting the solenoid valve output pins, as this will blow the relays on 
the power board, requiring a replacement or repair.

The valve connector cable should be connected to the 15-pin connector at the lower left 
corner of the analyzer. There are six pairs of wires with connectors labeled V1, V2, … V6 with 
2-pin female Molex connectors (Molex #43020-0200) for connection to the solenoid valves. 
For valves wired with matching Molex connectors, connect V1 to the solenoid valve 1, V2 to 
solenoid valve 2, etc. Do not connect the solenoid valve to the analyzer ground – use only the 
provided electrical connectors.

G.5   Setting up a Rotary Selector Valve
The (null modem) 9-pin female connector cable should be attached to its corresponding 9-
pin male port (COM 2) on the analyzer. The other end of the cable connects to the 9-pin port 
on the A0311. Please note the 9-pin connector cable is not supplied with the instrument – 
only as part of the A0311 kit.

G.6   External Valve Sequencer Software Overview
The External Valve Sequencer software allows the user to define a sequence of (repeating) 
steps within which rotary valve positions and/or solenoid valve positions can be defined 
uniquely at each step.

G.6.1 Opening the Sequencer
From the CRDS Data Viewer, Users dropdown menu login using your username and 
password. Then, from the Tools drop-down menu, select Show Valve Sequencer GUI. The 
Picarro valve sequencer window displays, but typically sitting behind the main GUI. Hitting 
alt-tab brings the Valve Sequencer GUI to the front.

CAUTION

mailto:support@picarro.com
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Figure 104 - Launching the Valve Sequencer GUI

G.6.2 Valve Sequencer UI Menus
The sequencer GUI provides the following dropdown menu options.

Figure 105 - Valve Sequencer UI Dropdown Menus
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The following figure provides functional descriptions of the External Valve Sequencer UI.

Current step and valve state status panel (when sequencer is running)

Sequencer configuration controls

Figure 106 - External Valve Sequencer UI

The Current Step #, the Remaining Time (min), and the Current Valve State are shown in the 
topmost row of the valve sequencer command window. The duration of each step is set in 
decimal minutes; for example, 15 seconds would be entered in as 0.25 minutes.

While a sequence is inactive, Current Step # will typically read “0”. Once the user has 
selected Start Sequence from the Action menu, or once the user clicks Apply from the GUI, 
the Current Step value will change to 1, corresponding to the first step defined below it, and 
will continue through the steps, returning to Step 1 once the last step is completed. 

If a user wishes to perform a set of steps only once, they may set a final step with a very long 
duration, or wait until the sequence is finished, and at the end of the last step, click Stop 
Sequence from the Action menu.

1

2
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Under Action, the Go to First Step menu item restarts the sequence from step 1. When the 
first step in the sequence starts, the “Current Step” value will change to “1”. This will begin 
the sequence if the sequence is currently active.

G.7   Programming and Saving a Valve Sequence
Each “step” in the sequence can be used to set the rotary valve to a given position or activate 
selected solenoid valves for a set period. Multiple steps can be carried out in sequential 
order to switch between different gas sources, flush out a manifold, or to perform other gas 
handling operations. 

1. Create the number of desired steps in the sequence by clicking the up/down arrow for 
Total Steps.

2. For each step, select the box for each solenoid valve to be opened. The check mark in 
the Current Valve State window indicates a solenoid valve is set to its “normally closed” 
value in the case of a 3-way, or to its “open” value in the case of a 2-way on/off valve. The 
positions from left to right correspond to solenoid valves V1 to V6.

3. The rotary selector valve position can be set in the column labeled Rot. Valve Code. 
Enter the number that corresponds to the desired valve position. A value of 1 in this field 
corresponds to position 1 on the rotary valve. Only one rotary position can be selected 
per step. 

4. The upper right box, Current Rot. Valve Code, displays the current value while a 
sequence is active. It should be white if a rotary valve is connected, turned on, and 
detected by the software. If the box is grayed out, the rotary valve is not detected (if so, 
consult your rotary valve manual).

5. For each step, set the desired Duration. This is determined by the value entered in the 
Duration (min) field, where the duration of the step is in minutes. If duration values are set 
to <0.1 minutes, they may not be carried out accurately.

6. The Valve Code column (not used with the rotary valves) is a configuration-dependent, 
read-only display field that shows the total state of that particular step in a numerical 
binary sum of form 2 (Valve Number -1). When powered, the following valve values are 
produced, and then added together for the final Valve Code.

  Valve 1 Powered = 2(Valve number-1) = 2(1-1) = 1

  Valve 2 Powered = 2(Valve number-1) = 2(2-1)= 2

  Valve 3 Powered = 2(Valve number-1) = 2(3-1)= 4

  Valve 4 Powered = 2(Valve number-1) = 2(4-1) = 8

  Valve 5 Powered = 2(Valve number-1) = 2(5-1)= 16

  Valve 6 Powered = 2(Valve number-1) = 2(6-1)= 32
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The maximum displayable value is 63 (=1+2+4+8+16+32), when valves 1-6 are all 
powered. All other combinations of valves are unique binary sum values which denote 
the specific combination of any of the six valves.

This Valve Code value active at a particular point in time can be shown in the main 
Picarro software GUI as SolenoidValves or sometimes ValveMask (this may require 
going to Settings > Service Mode > password picarro). The Rotary valve code can be 
displayed as MPVPosition.

Figure 107 - Example 15 Minute Sequence

Above is a 15 minute valve sequence. It opens 5 minutes for each solenoid valve (#1, 
#2 and #3), and each of rotary valve (#4, #5 and #6).

7. Once the valve sequence has been programmed, it can be saved by selecting Save Valve 
Sequence File under the File menu (Figure 105). The sequence may be saved with any 
name the user chooses. 

NOTE
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G.8   Loading and Running a Saved Sequence

G.8.1 Loading a Saved Sequence
1. Under the File menu, select Load Valve Sequence. 

All the sequence files are in:

/home/picarro/I2000/InstrConfig/ValveSequencer/Name of the Sequence File

2. To load an existing valve sequence file, select the desired sequence name. 

If the user has been running a different sequence from the one that was loaded, the user 
needs to press Run Next Step to initialize the newly selected sequence, or alternately go 
to File > Go To First Step and Start Sequencer.

G.8.2 Running a Sequence
1. Under the Action menu, select Start Sequencer.

This selection will change to Stop Sequencer once the sequence starts. (The sequencer 
should be activated if it was disabled, but not necessarily to change from one sequence 
to another.) The sequence will repeat itself indefinitely until disabled or the software is 
exited. 

2. Once the sequencer is running, the user can select Hide Sequencer Interface under the 
Action menu; the sequence will continue to run even with the UI hidden, and will 
automatically continue if the instrument ever loses power from the wall and restarts after 
power is restored. (However, the timing of the sequence will be offset relative to the 
intended cadence.) 

3. To bring the sequencer interface back into view, from the main Picarro GUI, go to Tools > 
Show/hide Valve Sequencer again.

G.8.3 Skipping Steps or Advancing to a Particular Step
If desired, the valve sequence can be forwarded to the next step of the sequence by clicking 
the Run Next Step button on the UI. To jump to a particular step, increment the Run Step # 
field and click Apply.

G.8.4 Stopping the Sequencer 
1. Under the Action menu, select Stop Sequencer. 

This will leave all valves in their current state. In some situations, it is convenient to 
program the last step in the sequence to be a safe or default valve state. 

2. Should the user need to put the solenoid or rotary valves into a safe/default state, the 
sequencer can be advanced to the last step using the Run Next Step button. 
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G.8.5 Resetting Valves
Under the Action menu, selecting Reset All Valves will deactivate/reset all valves to their 
default state. 

G.9   Scheduling a Sequence
Users may schedule a sequence to start at a particular time in the future, often at the top of 
the hour, or at midnight for a recurring sequence with an hourly or daily cadence. The 
Schedule Sequence button is typically greyed out when the user shows the valve sequencer 
because the start time has passed. To begin a run in the future, select the desired date under 
Start Date, and the desired time under Start Time. When both values are in the future, the 
Schedule Sequence button will become active, and the user may click it. When the 
scheduled time arrives, the sequence will start automatically.
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H Remote Analyzer Access
Remote access allows you to access and control the analyzer from another computer from 
anywhere, enabling troubleshooting, file access, and remote work. This guide covers 
TeamViewer® and RealVNC®which are third-party applications.

The analyzer comes with TeamViewer and RealVNC preinstalled. However, you must 
install the application you plan to use on the device you want to control from.

H.1   TeamViewer
The TeamViewer application allows remote viewing of the analyzer and data access.

H.1.1 Locating ID and Password
TeamViewer requires and ID and password to establish a remote connection. Use the 
following procedure to locate the ID and password of the remote computer (analyzer).

1. On the analyzer, open TeamViewer. If you are not logged in, the ID and password are 
displayed in the main interface.

ID and Password

Figure 108 - TeamViewer Main Interface

2. When logged in, the ID and Password displays in the Remote Support window.

NOTE

1
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ID and Password

Figure 109 - TeamViewer Remote Device ID & Password

3. Note the ID and Password of the remote computer (analyzer) for use in the next step.

H.1.2 Connecting to Remote Computer (Analyzer)
Now that you have the ID and the password, use the following procedure to connect to the 
remote computer (analyzer).

1. If not already installed, download and install TeamViewer on the device you wan to 
connect from.

2. Open TeamViewer Remote and sign in.

3. Go to the Remote Support menu on the left-hand side of the interface.

4. Within the Provide Support section, enter the remote device's ID and click Connect.

ID field and Connect button

Figure 110 - TeamViewer Entering Remote Device ID & Password

1

1

https://www.teamviewer.com/
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5. Now enter the remote device's password and click Connect.

You successfully connected your remote device (analyzer).

H.2   RealVNC
The RealVNC application allows remote viewing only. Data access is not available. Follow 
the procedure to connect to the remote computer (analyzer) using RealVNC.

1. If not already installed, download and install RealVNC Viewer on the device you wan to 
connect from.

2. Open RealVNC Viewer and sign in.

3. From the toolbar select File and New Connection.

4. Enter the IP address of the remote computer (analyzer) and a name if desired. Click OK.

Enter IP address and description

Figure 111 - RealVNC  Properties

5. From the main menu, double click on the Computer to establish a remote connection.

1

http://www.realvnc.com/
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Remote connection (analyzer)

Figure 112 - RealVNC Remote Connection Entries

6. From the Authentication window enter picarro for the password and select Remember 
password. Click OK.

Enter and save password

Figure 113 - RealVNC Authentication

You successfully connected your remote device (analyzer).

1

1
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I Linux Keys and Commands
This section describes the Linux Ubuntu shortcut keys and terminal commands. Each entry 
specifies its function, syntax, and usage context. The following keys and commands are 
available for reference and application.

I.1   Keyboard Shortcuts
The following table provides useful shortcut keys.

Table 17 - Shortcut Keys

Keys Description

Alt + Tab Switches between running applications

Alt + F2 Run command

Alt + Space Shows current window operations

Alt + F7 Moves current windows with keyboard

Ctrl + Alt + Up/Down Switches between virtual workspaces

Super + Drag Moves window

Super + Up Maximize window

Super + Down Undo maximize window

Super + D Show desktop

Screenshots (/home/picarro/pictures)

PrintScreen Captures entire screen

Alt + PrintScreen Captures current window

Screen Recordings (/home/picarro/videos)

Alt + Shift + Ctrl + R Enables recording

I.2   Command Terminator
Options for opening the Linux command Terminator:
 l Alt + F2, type gnome-terminal and enter.
 l On desktop open space, right-click and select Open in Terminal.
 l From Picarro Launch Pad, Administration tab, select Launch Shell.
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I.3   Commands
The following table provides useful shell line commands.

Linux commands are case sensitive. The command must be exact for the system to 
recognize and execute it.

Table 18 - Linux Shell Line Commands

Keys Description

> picarroMenu Opens Picarro OS utilities.

>lsb_release –a
Prints certain Linux Standard Base (LSB) and 
distribution information.

>xrandr
Lists all available display output interfaces and its 
state (DP, DVI, HDMI).

>xrandr --output DP1 --auto
Enables DPI with auto setting. DPI is the video 
streaming port.

>xrandr --output eDP1 --off
Disables eDPI, the virtual display generated when no 
monitor is connected.

> ps –ax | grep python Lists running Python processes.

> kill ### Terminates running process.

> nautilus Opens file manager, {Ctrl+L ...shows address bar}.

>caja Opens file manager, {Ctrl+L ...shows address bar}.

>gedit Opens text editor.

>ip -br a Brief IP report.

>du -sh Summarizes file space usage in current directory.

>df -h Report file system disk space usage.

Remote Access

>teamviewer Opens TeamViewer

>anydesk Opens AnyDesk

NOTE
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J Relative Humidity Conversion
H2O Concentration (C) is reported in units of parts per hundred or percent (%) and is a 
volumetric fraction of water vapor to total (wet) gas. Via the ideal gas law, the concentration 
can be related to the water vapor pressure (PW) and the total pressure (P).

A popular way to express volumetric concentration when working with humidity is in terms of 
total (dry) gas.

The two concentration definitions can be related by

    or    

Relative Humidity (RH) is the percentage of water vapor pressure to the saturated water 
vapor pressure (PWS).

There are several empirically generated equations that provide the saturation vapor pressure 
as a function of temperature (T). A simple and effective relationship for use within a 
temperature range of -45 °C to 60 °C is provided by the Mangus formula with coefficients 
adjusted by Sonntag [1].

Where, α = 4.584 Torr, β = 17.62 and λ = 243.12 °C
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Combining the equations shown above yields the final relationship for converting the wet and 
dry definitions of concentration to relative humidity.

For example, a wet concentration of 1.5% H2O at 18.0 °C and 760.0 Torr yields a relative 
humidity of 73.8%.

A dry concentration of 1.5% at 18.0 °C and 760.0 Torr yields a relative humidity of 72.7%.

[1] Sonntag D.: Important New Values of Physical Constants of 1986, Vapour Pressure Formulations based on the 
ITS-90 and Psychrometer Formulae; Z. Meteorol.70 (1990) 5, 340-344
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K Introduction to Technology
Picarro analyzers use time-based, optical absorption spectroscopy of the target gases to 
determine concentration. They are based on wavelength-scanned cavity ring-down 
spectroscopy (WS-CRDS), a technology in which light re-circulates many times through the 
sample, creating a very long effective path length for the light to interact with the sample, 
thus, enabling excellent detection sensitivity in a compact and rugged instrument. 

The Picarro analyzer is comprised of two modules:
 l The analyzer contains the spectrometer, sample chamber, and a computer with a hard 

drive to store and analyze data. The single analyzer module controls the operation of the 
system and converts spectroscopic measurements into gas concentration data.

 l The external vacuum pump draws the sample gas through the instrument.

K.1   Cavity Ring-Down Spectroscopy (CRDS)
Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and isotopologue (e.g., 
H2

18O, 13CO2, 15N14N16O) uniquely absorb specific wavelengths of near-infrared light. The 
strength of the light absorption is related to the concentration of a molecule in a sample and 
the distance that light travels through the sample, called the path length. 

Conventional infrared spectrometers are typically only sensitive enough to detect trace 
gases at levels in the part-per-million. Cavity Ring-Down Spectroscopy (CRDS), on the other 
hand, is one thousand to one million more times sensitive. 

The increased sensitivity of CRDS is due to the design of the sample cavity and the time-
based measurement. In the cavity, a series of mirrors reflects the infrared light through the 
sample, increasing the path length. For a Picarro cavity of only 25 cm in length, the effective 
path length of the cavity can be over 20 kilometers.

In Picarro analyzers, light from a single-frequency laser enters a cavity where three mirrors 
reflect the laser light as seen in Figure 1. The light enters through the mirror closest to the 
laser, bounces off the angled mirror in the lower right corner of the cavity, travels to the 
hemispherical mirror at the top of the cavity, bounces toward the mirror in the lower left 
corner of the cavity, and then returns to the first mirror. This motion becomes a continuous 
traveling light wave, which is represented by the dark orange path in Figure 1.
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Figure 114 - Schematic of the Picarro CRDS analyzer cavity

When the laser is on, the cavity quickly fills with laser light. A small amount of the laser light is 
transmitted through the mirror closest to the photodetector, which turns the incident light 
into a signal that is directly proportional to the light intensity in the cavity.

When the photodetector signal reaches a threshold level (in a few tens of microseconds), the 
laser is turned off. The light contained within the cavity continues to bounce between the 
mirrors (about 40,000 times). Since the mirrors have slightly less than 100% reflectivity 
(99.999%), the light inside the cavity steadily leaks out of the cavity. The intensity of the light 
reaching the detector decreases, falling exponentially until it reaches zero. This decay, or 
"ring-down,” is measured in real time by the photodetector.

K.2   Relating Ring-Down Time to Absorption Intensity
The time it takes to ring-down is inversely related to the total optical loss in the cavity, 
including the strength of molecular absorption at a given wavelength of light. For an empty 
cavity, the time it takes for the intensity to decrease by a given percent is determined solely 
by the reflectivity of the mirrors. A cavity containing gas that absorbs light will have a shorter 
ring-down time than an empty cavity. As the light circulates in a cavity with a gas sample, the 
molecular absorption by the gas results in a decrease of the light intensity.

Determining absorption intensity at a specific wavelength requires comparing the ring-down 
time of an empty cavity to the ring-down time of a cavity that contains gas. A cavity can be 
empty if it contains no gas; it will also appear empty if the molecules of the sample inside the 
cavity do not interact with the specific wavelength of light.
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Picarro instruments gather measurements from an “empty” cavity by switching the light to 
wavelengths that are not absorbed by the target molecules. The analyzer subsequently 
measures ring-down times at wavelengths that are absorbed by the target gas. The analyzer 
automatically and continuously compares these two types of ring-down times, and the 
software uses those comparisons to calculate absorption intensities.

Figure 115 - Light intensity as a function of time in a CRDS system

K.3   Converting Absorption Intensity to Concentration
Plotting the absorbance at each measured wavelength generates an optical spectrum. This 
spectrum contains absorbance peaks that are unique to each molecule in the sample. The 
height of a particular absorption peak is proportional to the concentration of a molecule that 
generated the signal. 

The height of the peak is calculated by subtracting the maximal absorbance from the 
baseline absorbance. Figure 116 shows a plot of ideal optical spectra with a clean, uniform 
baseline on either side of the absorption peak.
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Figure 116 - Absorption Spectral Curve

However, optical spectra often contain several absorption lines, nested closely together. A 
particular absorption peak may be visible between lines, but the absorption may not return to 
the baseline before it rises in response to another molecule. Picarro analyzers calculate the 
baseline underneath a poorly resolved peak by modeling the absorption peaks from other 
surrounding molecules and subtracting contributions from neighboring peaks to the 
absorption intensity. 

K.4   Spectral Precision and High Sensitivity Measurements
Picarro analyzers contain two features that provide high spectral precision:
 l Proprietary wavelength monitor (WLM) that measures the absolute laser wavelength to a 

precision that is a few orders of magnitude narrower than the spectral linewidth: Picarro’s 
patented WLM measures absolute laser wavelength to a precision more than 1,000 times 
narrower than the observed Doppler-broadened linewidth for small gas-phase molecules. 
The instruments lock the laser to the WLM, and then the monitor tunes to wavelengths 
known to be maximally and minimally absorbed by the target molecule. The result is 
closely clustered absorption intensities, measured at wavelengths just before peak 
absorption, at peak absorption, and just after peak absorption, as the absorbance returns 
to the baseline.

 l Precise temperature and pressure control in the sample cavity: Accurate absorption 
measurements at precisely known wavelengths account for little unless the temperature 
and pressure of the CRDS measurement cavity are known. The observed line intensity 
and shape depend on the temperature and pressure inside the sample cavity. Small 
temperature and pressure instabilities can result in large concentration errors due to 
fluctuating peak heights and baselines. To completely minimize instrument measurement 
drift, temperature and pressure must be actively stabilized to constant values. 
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For precise temperature control, the sample cavity is surrounded by layers of thermally 
insulating material to provide a high degree of passive thermal stability. The cavity is further 
actively stabilized by means of a solid-state heating system locked to the output of a thermal 
sensor. This enables the temperature of the cavity to be within 20 mK of the set temperature. 

For precise pressure control, the cavity pressure is monitored using a high-linearity pressure 
transducer. The system computer uses this pressure data in a feedback loop to control 
proportional valves that adjust the inlet and outlet gas flow of the cavity. 
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L Limited Warranty
Limited Warranty for Picarro Products and Peripherals.  Picarro warrants that during the 
Warranty Period the Picarro Products and Peripherals will be free from substantial defects in 
material and workmanship under normal uses, and will substantially conform to Picarro’s 
published Specifications for the Product. “Specification" means the then current user guide, 
technical specification or other product documentation prepared by Picarro (and does not 
include marketing collateral).  This limited warranty extends only to the original end-user 
(“Customer”) of the Product.

Warranty Period.  The Warranty Period commences upon shipment of the Product and the 
Warranty Period continues for a period of 13 (thirteen) months (for shipments directly to 
customers) or 15 (fifteen) months (for shipments to a Picarro partner).

Warranty Remedies.  Customer's sole and exclusive remedy and the entire liability of Picarro 
and its suppliers under this limited warranty will be, at Picarro’s option, repair of the Product; 
or shipment of a replacement Product within the warranty period and according to Picarro’s 
replacement process; or a refund of the purchase price if the Product is returned to Picarro, 
freight and insurance prepaid. Picarro replacement parts used in Product replacement may 
be new or equivalent to new.

In the event Picarro repairs or replaces the Product under this warranty, then the Warranty 
Period will be extended for the longer of a) ninety (90) days, or b) the period of time during 
which Customer has been unable to use the Product based upon the date on which the 
Customer or partner first reported to Picarro the problem giving rise to the warranty claim.

As part of the Limited Warranty, during the Warranty Period Picarro may provide: (1) 
telephone and email technical support, including remote log-in capabilities during Picarro’s 
regular support hours and (2) software updates that Picarro generally makes available 
without additional cost. Picarro will provide all parts and services required to repair or 
replace the Product, provided that repairs will be performed remotely or at Picarro’s factory.  
Picarro reserves the right to use local, authorized partners to assist in providing warranty 
repairs and/or factory returns and End Customer will cooperate with such local partners.

Picarro's obligations hereunder are conditioned upon the return of the defective Product in 
accordance with Picarro’s then-current Return Material Authorization (RMA) procedures.  
Customer or partner will pay for shipping of the Product to Picarro, and following repair of the 
Product Picarro will pay for return shipment to the Customer or partner under Incoterm DDP. 
Any other costs of shipment will be Customer’s or partner’s responsibility. Customer must 
follow instructions provided by Picarro for packaging and shipping the Product.

Warranty Restrictions. The above Product warranty does not apply if the Product (a) has 
been altered, except by Picarro or by Customer with Picarro’s prior written approval, (b) has 
not been installed and used in accordance with Picarro’s Specification, (c) has been 
subjected to abnormal physical or electrical stress, abnormal environmental conditions, 
misuse, negligence, or accident; (d) is licensed for beta, evaluation, testing or demonstration 
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purposes; and (e) does not extend to recovery or replacement of any data from any medium.   
The Warranty Periods for spare parts, consumables and RMA repairs are not included in this 
document and are described under the Support Service Terms document.

Disclaimer:  Picarro disclaims all other warranties, either express or implied, including 
warranties of fitness for a particular purpose.  Except as set forth in this document, or as 
otherwise expressly agreed in writing by Picarro, there are no other warranties applicable to 
Picarro Products.



About Picarro         
Picarro is a leading provider of solutions to measure greenhouse gas (GHG) concentrations, trace 
gases, and stable isotopes across many scientific applications, along with the energy and utilities 
markets. Our patented Cavity Ring-Down Spectroscopy (CRDS) is at the heart of all Picarro instruments 
and solutions, enabling the detection of target molecules at part per billion or better resolution.

Product Support

Utilize Picarro support resources for product support. Join the Picarro community to ask 
questions and get answers, search the document library for datasheets and user manuals, 
download software, and purchase products and replacement parts. 

 
Access to online community forums and software downloads are available only for registered 
Picarro customers with login credentials. If you do not have an account, you can register by 
using the community and software download links below.

 

  Picarro Document Library
  Picarro Community (Forums)
  Picarro Software Downloads
  Picarro Literature (Scientific Resources)
  Picarro Web Store

Contact Picarro for questions regarding specific applications and additional information.

Picarro Customer Support (USA) Picarro Customer Support (International)

Email: support@picarro.com Email: support@picarro.com
Phone: +1 408 962 3991 Phone: +31 85 888 1650

https://www.picarro.com/support/documents
https://www.picarro.com/support/community
https://www.picarro.com/support/downloads
https://www.picarro.com/support/literature
https://store.picarro.com/
mailto:support@picarro.com
mailto:support@picarro.com
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